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Organization

The User Guideis organized into several chapters and offers a comprehensive index as well.

o Chapter1, "Introducing Jury Instruction Selector," introduces you to Jury Instruction Selector
and tells you how to install the program, including updates available from West's web site.

e Chapter 2, "Getting Started with Jury Instruction Selector," describes how to getstarted using
Jury Instruction Selector. It offers a tour of the application window, as well as several general
procedures such as starting and exiting the program.

o Chapter 3, "Managing Instruction Files," focuses on managing instruction files (both
instruction sets and instructions lists). It begins by defining the difference between instruction
sets and instruction lists. It then offers step-by-step procedures for managing these sets and
lists (starting new ones, opening existing ones, saving, and so forth).

o Chapter 4, "Working with Case Information," explains how to set up the information that is
specific to a case, such as the presiding court, the attorney, the parties, acts, dates, locations,
and so forth. Later, you can auto-populate your Selected Instructions with this information.

o Chapter 5, "Working with Jury Instructions," focuses on working with instructions. Itincludes
procedures for viewing the text and Commentary of Master Instructions, for finding specific
instructions, forselecting instructions forinclusion in aninstruction set, andfor editing
instructions in various ways. (This chapter does not cover how to create Personal Instructions;
seeinstead Chapter7.)

o Chapter6, "Printing Jury Instructions," describes the various formats in which you can provide
printed jury instructions. It also offers procedures for setting various printing preferences and
for printing, previewing, and printing instructions to a file.

o Chapter 7, "Creating Personal Instructions," explains how to create custom instructions, called
Personal Instructions. Once created, they can be selected forinclusionin an instruction fileand
edited with case information justthe same as Selected Instructions based on Master
Instructions.
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Preface. About This Guide
Companion resources

Companion resources

In addition to this User Guide, you can find moreinformation about Jury Instruction Selector in several
companion resources:

e What's New - This PDF document answers offers highlights of the new and enhanced
program features. For more information, see" Find out what's new," page17.

e Comprehensive Help system — The program's Help system covers much of the material inthe
User Guide. Italso offers a series of Frequently Asked Questions (FAQs). See "Use the Help
system," page 17.

e Quick Start Guide - This short document (provided both as a PDF installed with the program
and as a printed guide for new subscribers) gives you quick instructions forinstalling the
program and for getting oriented toits user inteface and most used features. To open the PDF
while running the program, choose Help > Quick Start Guide.

Get assistance from West

If you have a question about or a problem with Jury Instruction Selector and cannotfind the answers
intheHelp system or the Quick Start Guide, please contact West forassistance.

Software problems and questions

Customer Technical Supportoffers assistancewith software products. Call 1-800-848-3475 or send
email to west.appsupport@thomson.com.

IMPORTANT! ABOUTALTERNATIVE OPERATING ENVIRONMENTS: California Jury Instruction
Selector is designed to be compatible with the standard Windows operating systems listed in the
system requirements and to function correctly underthose installation configurations outlinedin
this User Guide. Customer Technical Supportis available to all users working underthose
conditions. West does not claim compatibility with any other operating systems, multi-user
environments, or installation configurations such as Mac OS, Linux, Novell, Citrix, Teminal
Services, etc., and we areunable to provide support for Califomia Jury Instruction Selector in any
altemate operating environment or installation configuration not specifically included in this User
Guide.

Training

West's training group offers by-appointment, one-on-one customer training overthe telephone. Our
trainers offer live, web-based demonstrations while answering specific questions to help users learn
the program quickly. To make an appointment with a trainer, call 1-800-328-0109.

Questions about your West account

Customer Service assists with account questions. You canreach usat 1-800-328-4880 or send
email to west.customer.service@thomson.com.

Give feedback to West

If you would like to make comments or suggestions regarding the features or functions of Jury
Instruction Selector, please send email to the product team at jis.feedback@thomsonreuters.com.

NOTE: The product team reads all comments sent to the above email address, but cannotdirectly
respond to each message. When you need immediate assistance, call 1-800-848-3475.
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Preface. About This Guide
Stay current with the latest updates

To offer feedback on a particular topicin the program's Help system, use the Send feedback about
this Help topic link at the upper right comer of the Help window.

Stay current with the latest updates

Be sure to sign up for West's free notification serviceregarding web updates. Wheneverwerelease a
new updateof Jury Instruction Selector, you'll get an email message from us with a link to the update.
If you did notsign up during installation, click or copy this URL into your browser:
https://pc2.mypreferences.com/ThomsonReutersUSLegal/Profile

You can also get web updates on demand. With the program running, click the Check for online
updates link on the Start tab or choose Help > Check for Updates. Or, click or copy this URL into
your browser: info.legalso lutions.thomsonreuters.com/software/ca-selector

NOTE: Forinformation about other West products, visit legalsolutions.thomsonreuters.com/law-
products/ or call 1-800-328-4880.

California Jury Instruction Selector User Guide (Version 6.1) ix
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CHAPTER 1. INTRODUCING JURY
INSTRUCTION SELECTOR

This chapter introduces you to Jury Instruction Selector and tells you how to install the program, including updates
available from West’s web site.

What is Jury Instruction Selector? - . . oo 1
Y A = 0 T U1 =] 0 =T 2
Important notices regardinginstallation -.............. e e e eaeeeaeeeeeeaeeanaaan 2
Install Jury INStruction SELECTOr . . . e e e e e e e e e e e e e e e e e 3
Localinstallation mes sia e s o S S S L e e e S S S S L iy L L s S S e T ad Sl T S S i Laa s 3
Networkinstallation s e s S e S A e S D L B S e B B S S SR SR E s 7
Workstationinstallation s e m s s s s S i S N e s L S B N L S S S B SR s 9
Installweb Updates :zc e st e L L L T L S L R S o L S Ty S D R L B s i it 11
Reinstall or uninstall Jury Instruction Selector - . ll_l___. 11

What is Jury Instruction Selector?

Welcome to California Jury Instruction Selector, a Windows®-based software application originally
designed by Judge Richard A. Adler of the Superior Court of Los Angeles.

California Jury Instruction Selector works in both stand-alone and networked environments. With it,
you can create personalized, "approved" criminal and civil jury instructions. You can:

e complete information about yourcase
o searchforand selectrelevantjury instructions
o editand printrelevant, case-specific jury instructions for submission to the court

With the program's searching and sorting features, you can scroll through the masterlist of jury
instructions, jump to specificinstructions, or perform targeted searches for specific terms or phrases.
The program also includes commentary for guidance in selecting the most relevantjury instructions.
Onceyou have choseninstructions, you can quickly adapt them to meet the requirements of a specific
court case.

Jury Instruction Selector offers these useful features:

o Caseinformationtab - Hereyou store all of your case-specific information such as the name
and number of the case, courtand attorney information, the names of parties, and all other
persons, entities, acts, dates, items, and locations that are pertinent to the case.

o Multiple print formats — Allow printing jury instructions in the traditional single-pageformat
(Rule 201), on Los Angeles County Forms 176/177, or in a booklet containing numerically
arranged instructions, table of contents, and separatedisposition table.

o Editing features - Spell checker, auto-populating selected instructions with stored case
information, and the ability to create custom instructions provide completely case-specific
documents.

California Jury Instruction Selector User Guide (Version 6.1) 1



Chapter 1. Introducing Jury Instruction Selector
System requirements

o Coverage of civil issues — Includes negligence, torts, products liability, vicarious
responsibility, and contractual relationships.

o Coverage of criminal issues - Includes definitions, general rules, evidence, homicide,
accessory, crimes against the government, life, security of person, sex, public health, safety
and welfare, property, misdemeanors, and defenses.

System requirements

Beforeinstalling Jury Instruction Selector, make sure your computer meets these minimum
requirements:

e Operating system - For all installations, .NET 3.5 or higher is required. For a local or
workstationinstallation, oneof thefollowing is required: Microsoft Windows 10, 8, 7 (32- or
64-bit), or Vista (SP2) (32- or 64-bit). For a network installation, a Microsoft Windows-based
server envionment (Windows Server 2003 or later) is recommended.

e Processor — Pentium [l 500 Mhz

o Memolry - 128 MB of available RAM (256 MB recommended)

o Storage-250 MB of availablestorage space

e Monitor - 800 x 600 or higher resolution

e Printer — Laser printer with Printer Control Language (PCL) Level 4 or 5 support
o Media —CD-ROM drive

e Westlaw access — To use Westlaw links within the program, you must have:

o An Internet browser such as Microsoft Internet Explorer 6.0, Firefox 2.0, or Safari 2.0 or
later, with JavaScript and cookies enabled and frames fully supported and pop-ups
allowed

o A connectiontotheInternet

Important notices regarding installation

IMPORTANT! ABOUTALTERNATIVE OPERATING ENVIRONMENTS: California Jury Instruction
Selector is designed to be compatible with the standard Windows operating systems listed in the
system requirements and to function correctly underthose installation configurations outlinedin
this User Guide. Customer Technical Supportis available to all users working underthose
conditions. West does not claim compatibility with any other operating systems, multi-user
environments, or installation configurations such as Mac OS, Linux, Novell, Citrix, Tetminal
Services, etc., and we are unable to provide support for Califomia Jury Instruction Selector in any
alternate operating environment or installation configuration not specifically included in this User
Guide.

IMPORTANT! ABOUT WORKSTATION INSTALLATION FROM MSI: Workstation installation
must be runon all computers using a networked version of Califomia Jury Instruction Selector. For
your convenience, a workstation installation can be rundirectly from the CA Jury Instruction
Selector.msi, bypassing setup.exe. However, the following Microsoft software (available on
Microsoft's web site) must be installed first on users' computers before the MSl installationis run:
(1) .NET Framework version 3.5.

(2) MDAC drivers version 2.8.

2 California Jury Instruction Selector User Guide (Version 6.1)



Chapter 1. Introducing Jury Instruction Selector
Install Jury Instruction Selector

IMPORTANT! ABOUT NETWORK DISTRIBUTION: Because of the number of different network
distribution applications available, West cannot support or offer advice on how to distribute our
software using third-party network distribution software such as ZENWorks or Microsoft's SMS.

Install Jury Instruction Selector

Jury Instruction Selector can beinstalled on a stand-alone computeroron a network and
workstations. This section describes three types of installations:

o Local - Installs the program, its database, and its support files (such as PDFs of reference
documents) to a local (stand-alone) computer.

e Network - Installs only the database and support files to a network location that can be
accessed by users running workstation installations.

o Workstation - Installs only the program on a networked computer (a "workstation") from
which a user will access the program database and support files from the network location.

Local installation

At any time during
the installation, you
can exit the setup
program by clicking
Cancel on any of the
wizard's windows.
You can then click
Yes to exit the
installation com-
pletely.

Alocal installationinstalls all files required to run Jury Instruction Selector on a stand-alone PC.
Have your key code(s) ready, as you will be prompted to unlock the program's modules during the
installation.

Exit all applications before beginning the installation procedure.

To perform a local installation

IMPORTANT! Beforeinstalling Jury Instruction Selector, review "Important notices regarding
installation," previous page.

1. Insert the Jury Instruction Selector CD into the CD drive.
ThelnstallShield Wizard window opens briefly as the InstallShield Wizard is prepared. When
the wizard is ready, the Welcome window opens. Click Next to begin.

10 €A Jury Irstrochion Selector - InstaliShield Wazsrd =)

Welcome to the InstaliShield Wizard for CA
Jury Instruction Selector

The InstalShi=lo(R) Wizard wil nstal CA Jury Insbuchion
Selector on your computsr. To continue, cideNext

VWARMING: This program is protectad by copwightlaw and
Intarnatanal restes.

2. On the Disclaimerwindow, review the disclaimerand click Next to continue.
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You may print the
disclaimer if you
wish.

You may print the
license agreement if
you wish. (Or, while
running the
program), choose
Help > User License
to view the license.

Flaage revien the folowing infarmation before proceeding.

West s not engaged In rendsring legal or ather professional amvice, andthis C- »
ROM (s not a substitule Tor the addce of an attorney. I you require legal or othel F
expert advice, you should szek the seruces of a competsnt attomsy or

professionsl

- e e - Rt .o~

After reading the copyricht nfoemation, did next o continue, Pmtil

[rgtaiEhed

Copyright © 2012 Thomson Reuters. All rights resered. No copyrighiis daimed by
Tnom3aon Reuters to the CACI ol Jury Instructions, Verdict Farms, Directions for
{Use. Sourcas and Authority, User's Guide, Life Exgedancy Tables, of Disgosition
Table. No copyright is claimed by Thomson Reuters to the text of the CALCRIM
criminal jury instructians, bench notes authonty, other Task Force and Advisory
Commiliee commeniary, Of references to secondary SQUICEs.

N e . " " LT

[

<Back || mNext> |[ cacel |

On the License Agreement window, review and accept the agreement and click Next to
continue.

Haase read the foliowing lcense agreement carefully,

@' T accept the terms in the icense agresment

" 1do nat acoept e terms 1 the ioerse agresment

[rotEitshed

Cahformia Jury Instruction Selector License Agreement -

ACCESS L0 and use of Califormia Jury Instruction Selector is subject to the terms and
condfions of the California Jury Instruction Selector License Agrzement below
(CAgreement’). a legal gocumen! between you and West a Thomson Reulers
business "West') or batween Wes! and the entily you represent. As used herain,
ou andlor the entty you represent ars collechvely referrea fo as “Licensee ”
Please read the Agreement it you agree with the terms and conditions of tha
Agreement and agree 10 be bound by them, acceptthe terms and continue with the
software installation  If you do not zgree with the terms and conditions of the
Agreement then da not continue with the Software Instaliation, and your orger will «

[

<Back || mext> || cacel |

Onthe Customer Information window, enter your customer information, and click Next to

continue.
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User Name=:

|Your Name

Orgarizetion:

[retdllSheld
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Install Jury Instruction Selector

Cancei |

On the Setup Type window, selectLocal. If you do not want the wizard to install a program
shortcut on yourdesktop, clear the Install a shortcut... check box. Click Next to continue.

Setup Type
Chaose the setup tyce thatbest suts your nzecs.

Flense zelect o zehup type.

@ Local - Al features will be instalied locally.
{ Retwork - Only content will be installed to share.
(_ Workstation - Client without content will be installed.

| V] Install 3 sharicut to Jury Instruction Selector on the Deskiop?

[retalEhed

[15et = defaut save path for workstation nstalls (Network natals onlyls

<gadk | Next>

Cancel |

]|

On the Destination Folder window, the default location where program files will beinstalled

is shown. Click Next to continue.
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We recommend "B CA Jury Instruction Selector - InstzliShicld Wizard
that you use the
default location, but

you may choose a

different one. l:'j Instal CA Jury Instruction Selector to:
C:\Program Files (xB6)\West\CA Jury Instruction Sel=ctor| |— Change.oo|

Chck Next to instal to this foder, or dick Changs to hetdl to a different folder. \\

[rgaiEhed

[ <Back ([ MNext> ][ cancel |

7. OntheRights Management window, any locked moduleis depicted by a padlockicon. To
unlock a module, enter its key and click Unlock. In response to the confitnation message,
click OK. The padlock iconwill change to the Jury Instruction Selector logo.

Enter or upcate nghts below,

£nter your key coce and cidc "Unlock.” [Fsuccessful, the padock icon wil change to the Jury
Instruchon Selector gy, Aepent for ench key code,

ﬁ Civil

é% Criminal

[ | o

rewibhed

[ <Back || mext> || cancel |

NOTE: If the key code is not recognized, an eror message appears. Click OK to dismiss the
message and re-enter the key code. If you continueto have a problem, call 1-800-848-3475.

Repeat to unlock the other module, if needed.
Click Next to continue.
8. Follow the rest of the wizard's windows to complete the installation.

9. Whenthe wizard is complete, click Finish to close.
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22 CA Jury Instruction Selector - InstaliShigld Wazard =

Instalishield Wizard Completed

The InstalShicld Wizard has successfuly nstalied CA Jury
Instrucion Selector, Cick Firish o exit the wizard.

: 5k Canze

10. The wizard will have started up yourdefault browser to load the West's Software Update
Notification Service web page. Hereyou can sign up for free product update notifications.
Select the products of interest, enter your contact information, and click Submit. (You will
need to close the browser manually.)

Network installation

A network installation installs the program's database and shared files (such as PDFs of reference
documents) to a network location. It does notinstall the program itself. Users running workstation
installations will be able to access the database and shared files from that network location.

Have your key code(s) ready, as you will be prompted to unlock the program's modules during the
installation.

Exit all applications before beginning the installation procedure.

NOTE: After completing the network installation, be sure to perfform a workstation installation on
each individual computer. See "Workstation installation," page9.

To perform a networkinstallation

IMPORTANT! Beforeinstalling Jury Instruction Selector, review "Important notices regarding
installation," page2.

1. Complete steps 1-4 of the local installation procedure (from page 3).
2. On the Setup Type window, select Network and do the following:

o Ifyou wantto seta default savepath forworkstation installations, select the check
box Set a default save path for workstation installs (Network installs only)? This will
automatically set the default save/load location in the Options window forall
workstations.

o Ifyou donot wantthe wizard to install a program shortcut on your desktop, clear the
check box Install a shortcut to CA Jury Instruction Selector on the Desktop?

Click Next to continue.

California Jury Instruction Selector User Guide (Version 6.1) 7



Chapter 1. Introducing Jury Instruction Selector
Install Jury Instruction Selector

Chooss the e=ip typs that best wiils your nesds.

Heage celect a s2tup typa.

 Local - All features will be installed locally.
@ Hebwork - Only content will be installed to share.
. Workstation - Client without content will be installed.

|} set 5 default save path for worketaton instals (Neowork instals only)?
|V Install 2 shortout to CA Jury Instruction Selector on the Desktop?

rstaiEhed

[ <Bak [  mext> ][ cancel |

3. On the Destination Folder window, the default location where program files will be installed
is shown. Click Next to continue.

NOTE: We recommend that you use the default location, but you may choose a different one.

Cldtlﬁexlmmnlmﬁsfdda,addd\mgzmhsldlmadlffe:mifwa_

l_“ instal CA Jury Instruction Selector to:
j C:\Program Files (xB6)\West\CA Jury Irstruchon Selector), | Cwngs... |

trataithed

[ <Back || mext> || cancel |

4. Ifyou elected to setthe default save path for workstations, the Workstation Default Save
Folder window opens, showing the program'sdefault save location. To change the default
save location, typea new, full path. Click Next to continue.
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\
\
Chck Next to set the save folder, or ddk Change to set a dfferent save folder,

I 1 Woarkstations should save thei work st
C:Ysers\Nitz \Cocuments | ] Change... J

[retalEhed

|<gag | Neax || cancei |

5. Follow steps 7-10 of the local installation (continuing from page 6) to complete the
installation.

NOTE: After completing the networkinstallation, be sure to perform a workstation
installation on eachindividual computer. See "Workstation installation," below.

Workstation installation

A workstation installation installs only the program on a computer that will access the database and
shared files from a network location. You must have already performed a network installation.

To perform a workstation installation

IMPORTANT! Before installing Jury Instruction Selector, be sure to review "Important notices
regarding installation," page 2.

1. Completesteps 1-4 of the local installation procedure (from page 3).

2. On the Setup Type window, select Workstation. If you do not wantthe wizard to install a
program shortcut on your desktop, clear the Install a shortcut... check box. Click Next to

continue.

Choose the setup type that best suils your needs.

Pleacs selact 2 setup type.

" Local - Al features will be mstalied locally.
" Hetwork - Only content will be installed to share.
@ Workstation - Client without content will be instafled.

[15et 5 defait zave path for wodkstation nstols (Network nstolis orly) s

|7 nstall 2 sharicot to €& Jury Instruction Selector on the Dasktop?

[retaibheid

[ <gmde [ ve> | [ concel |
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We recommend
that you use the
default location, but
you may choose a
different one.

3. On the Destination Folder window, the defaultlocation where the progamwill beinstalled is
shown. Click Next to continue.

C!dtl\bklmnmalmﬁsfdda,mdddlm@tnm!dlmadlﬁam!fnuer,

I‘ “,  Instal CA Jury Instruction Selector to:
.-—7 C:\Program Files {x86)\West\CA Jury Instruction Selector| | Changs... |

[rgtaiShed

[ <Back || mext> || cacel |

4. The next window to appear is the Network Database Folder window (notillustrated). If,
during network installation, you installed the database and shared files to a custom location,
click Change to open the Change Network Database Folder window. Navigate to and select
the custom location and click OK. Back on the Network Database Folder window, click
Next to continue.

Change Network Database Folder
Erawse to the retwork datsbase foioer.

ook e

2] O& Jury Instruction Selector i I | dl

5. Follow steps 7-10 of the local installation (continuing from page 6) to complete the

installation.

10
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Install web updates

You might find it helpful to regularly consult the Jury Instruction Selector software downloads web
page forimportant product information and updated files. Visit the followingweb page, where you'll
find download and installation instructions for web updates.

info.legalsolutions.thomsonreuters.com/software/ca-selector

Youcan also sign up forthe free Software Update Notification Service. Each time a product you
request notification foris updated, you will receive a notification messagevia email with a link to the
update. The notification will also include a list of the new features or fixes included in the update. To
sign up fortheservice, visit thefollowing web page:

https://pc2.mypreferences.com/ThomsonReutersUSLegal/Profile

Onceyou begin using Jury Instruction Selector, you can check for updates right from the program
itself.

Reinstall or uninstall Jury Instruction Selector

To reinstall or uninstall Jury Instruction Selector, use yourstandard Windows feature for adding or
removing programs. In the Control Panel of Windows 7 or Vista, use Programs and Features. In the
Control Panel of Windows XP, use Add or Remove Programs.

Reinstalled files are always placed in the same folderas the original installation files.

Uninstalling the program does not delete userfiles (instruction sets and instruction lists). They will
still be stored in the program's default save location (folder). If you no longer need thesefiles, you
may delete the folder.

California Jury Instruction Selector User Guide (Version 6.1) n
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CHAPTER 2. GETTING STARTED WITH

JURY INSTRUCTION SELECTOR

This chapterdescribes how to get started using Jury Instruction Selector. It offers a tour of the application window, as well

as several general procedures such as starting and exiting the program.

Quick Start Guide for NEW USEIS - - - - - oo e e e ee e aeaeaeeeeeenan 13
Start up Jury Instruction Selector . ..o e 13
Jury Instruction Selector WindOwW - - - -« oo e e e 14
153 15
Toolbars st s s A S S S A L L L S s 2 S S S T i B S S ST S S iDL T IR 16
Get assistance as YoU WOIK =& s as o SR S L S o R B s s B s S A e e sl SisEn 3ss 17
Find out what's New s s e s B e s s R o S S L S L s e i S R B oS S 17
Use the Help Sy S e i s s s s o s i s L e T B S S s L L B s L S S B anu i ia s iy 17
Define the default district, court, and firm . . . eeeeeeaaeaan 18
Turn off the Startup OptioNS WINAOW . . e e e e e e e e e e e 20
Set the default save l0CatioN cacsves sramass St vaim e e s S 2 T St = S oS ST i S e it S i e i e 21
TUrn oN File RECOVEIY : sus inmsmagisess 2 on fiamm e e S £ 5 o Sae SRS o S S m eSS 2 e B e e ST & B B Draal S 21
Set diSplay OPLIONS guss s mmes s a5 R e i e S i e e 22
Set up chapter defaulls spsussessessass suewssemsens s sns s e ssenas s s s s sss §Hee e eess e s s eessesss 23
ADOUL CHAPTET AETAUITS ;erserazsmicimimtas o = i e m0irerate it oo b i b S S a3t el s eS8 52 b i 24
Open the chapter defaults for MOdifyiNg wuevereeesersesrsnesseresasessnsssssasssssssssassasssnnsnasns 27
Add default chapiars SIS S S S 27
Edit default Chapters - - - - e e e et 28
Delete default Chapters - . ... e e e e e e e e e e e e e e e e 29
Restore chapter defaults -.-...... .. ... A N L S A S e P A ST S RS S SR isea 30
Access Westlaw from within Jury Instrudtion Selector .. ... i 30
View reference materials S s oo s o o i D L e s L e L L S B i s S S B LS S LS LU TR S B s s 31
Exit Jury Instruction Selector /s st s it 0 S ir o o e o R LR Sy e U Sl 2ol S R N R i e 33

Quick Start Guide for new users

If you're a new user, besure to check out the Quick Start Guide. This short document (provided both as
a PDF installed with the program and as a printed guide for new subscribers) gives you quick
instructions for installing the program and for getting oriented to its userinterface and most used
features. To open the PDF while running the program, choose Help > Quick Start Guide.

Start up Jury Instruction Selector

To start Jury Instruction Selector

1. From the Windows Start > All Programs menu, choose West > CA Jury Instruction
Selector > CA Jury Instruction Selector. (Altematively, double-click the CA Jury Instruction
Selector desktop icon.)

The Startup Options window opens, listing instruction sets and lists (if any) that were
previously opened in Jury Instruction Selector.
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2.

~Startup Opuons

0 @ Crezate anawinstuction s

@  Openan existing ser

CAProgram Fleaswest, . \UsariAnghtv s j2
C\Program Fies\Wesl,  \User\Sact=r v Schukz s
CProoram Fiesivesti WWeaiee2 is

< " ’

[ ] s | 2]

NOTE: If you prefer, you can "turn off'" the Startup Options window so that it won't appear
the next time you start the program. (See "Turn off the Startup Options window," page 20.)

Do either of the following:
e To createa new instruction set, select Create a new instruction set and click OK.
The New Instruction Set window opens.

| .: 'i ii iii g 'ii f
Case Type
= Civil
 Crimingl
ok | cuca | D

Select thecasetype and click OK.

e Toopenanexisting instruction file, select Open an existing set, select the desired file
from among those listed, and click OK. (Altematively, click More Files to navigateto a
desired file).

The new file or the selected existingfileis loaded.

Jury Instruction Selector window

You do all of your work in the Jury Instruction Selector window (Figure 2-1). Thewindow's
components include:

Title bar - Identifies the instruction file that is currently loaded.
Menu bar - Provides access to the full set of the program's commands and resources.

Main toolbar - Provides quick access to commonly used features. (For moreinformation on
this and other toolbars, seepage 16.)

Tabs — From which you will add case-specific information, select jury instructions, and print
the jury instructions. Whenyou first startup the program, it opens at the Start tab, from which
you can quickly access details of the currently installed version of the program and check for
updates. (Formore information, see"Tabs," facing page.)

Status bar - Shows the type of case, the full path and file name of the instruction file, the
version of the program, and thedate as of which content (e.g., jury instructions, references)
was last updated.

14
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Do B v 2|

California Jury
Version 5.5.1

Last Updal=d 7730/2072 »

My 2012 Wab Updato »

Chack for ocdins upcsles »

File Instruchont Tooh  References Settings Help

Start | Case tnformatien | Jury Inetructore | Pt |

@

Instruction Selector

Conil C\Program Files 65\ West\CA lury Instruction §detwv\Uwﬁ%nhﬂ Version 5351 Lest Updeted: 7/30/2012

Figure 2-1. The main Jury Instruction Selector window, open at its Start tab

NOTE: When this window opens, it fills the entirescreen. Itis shown above resized to savespace
Feel freeto resizeit to a sizethat you find comfortable to work with.

Tabs

The Jury Instruction Selector window has several tabs (some further divided into pages) on which you
will do most of yourwork.

Table 2-1. Tabs of the Jury Instruction Selector window

Tab
Start

Case Information

Description
This tab offers links for:

o Viewing software and content information about the
installed version of the program.

o Viewing what's newin the installed version of the
program.

o Chedking for web updates. (See "Stay current with
the latest updates," page ix.)

This tab offers a series of pages onwhich you will enter
information about the case. For example, here you enter the
number and name of the case, the plaintiffs and defendants
in the case, and the district and court where the case is

being heard. You will also enter the names of various
individuals and other entities involved with the case in some
aspect, such as the name of a witness. Finally, you will enter
names of additional individuals and entities, as well as other
details pertinent to the case, such as dates, acts, property,
items, and locations.

See Chapter 4.
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Tab Description

Jury Instructions This tab offers a series of pages from which you will select
instructions to include in the jury instructions you are
preparing. From here, you can auto-populate the instructions
with the abovementioned case information, further edit
instructions manually as needed, fine-tune the order in which
they will appear when printed, and track the history and
status of the instructions' modifications.

See Chapter 5.

Print This tab offers a series a pages used for printing your jury
instructions. You will select which instructions you want to
print and then select a format (e.g., Booklet or Single Page).

See Chapter 6.

Toolbars

Jury Instruction Selector has several types of toolbars that give you quick access to features just
whereyou need them.

o Maintoolbar - As partof the main Jury Instruction Selector window, this toolbaris always
present. It gives you ready access to features such as New, Save, and Open.

o Tab toolbars — The program's various tabs, such as the Jury Instructions tab, each have their
own toolbar of tab-specific features.

o Pagetoolbars — Most of the tabs are furtherdivided into pages, someof which have their own
page toolbars of page-specific features.

o Window toolbars - Many windows, such as the Edit window whereyou will edit jury
instructions, also have theirown toolbars. (Some windows also have theirown menu bars
with even more features.)

&5 Jury Instruction S€ector for Windows - Ciuil [C\Program Files\WestUury Instruction Selecton Usen W ghtVSmith s
Rl Iretuction Tools References Settngs Heb

Dl | & | w|2| €

Start | Case Information  Jury Insuchoe |prct |

Master Instructions o 0 B3 & #4
Personal Instructions R R S | R

. Inst

Sethoctod Instayctions

Fle Edt Vew Tods Heb

& B G @ w|sm@d nm 40

Chapters/Sont

Hiatory

— JURY NOT SPECULATE AS TO REMOVAL OF CL

J | The 1smue of the Liablity of the defendant]s] [name of defenda
- 1 [i%] [are] no tonger before vou
r 5 Do not 1A thue For o Tt se not zel PR TTIRSE S

Figure 2-2. Various toolbars available in Jury Instruction Selector
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Get assistance as you work

When you need help using Jury Instruction Selector, check out the following resources. (Seealso "Get
assistance from West," pageviii.)

Find out what's new

There are two resources from which you canfind out what's new in the version of Jury Instruction
Selector installed on your computer.

o Viewthe What's New.pdf document, which is storedin the folder where the progamwas

installed. (This document is similar to the program's shipping insert.) To access this
document, do either of the following:

o If the program is not running, go to the Windows Start > All Programs menu and
choose West > CA Jury Instruction Selector > What's New.

[¢]

If the program is running, choose Help > What's New or click the Update>> link on the
Start tab. (The precise wording of the link will vary, depending on the version number
of the update.)

o Visitthe "What's newin Jury Instruction Selector" topic in the program's Help system.
Use the Help system

Jury Instruction Selector's comprehensive Help system is a convenient, easy way to find how-to
information and reference information.

To open the program's Help system at its first topic, click QI Help Contents on the main toolbaror
choose Help > Help.

PR T S ]
Pt

YO8 40 O 4 Wt 1 Jury BETaOs Selctr

Sand $aadrack shout thi Heip togle

PR WELCOM

ME TO JURY INSTRUCTION SELECTOR

\ =

& “Mmm o Welcoene

kS p“mmmdm Yikimma to SAatomo Jug instiecion Sdledon 3 Wndows8.bas vl software applcainn

3 Connting Personal hasucions pnanally sasignad &y Aaos Richard A Adlar of ha Supenor Coun of Loz Angsles

& Nanu Rslerince Caltomia Jury Nerucsan Salectar wirks n Rath stand-aons and nehwerad srgrenmenss . Wim
e} Winckrw, Ted, and Hessage Refenncy 1, Yo 030 G eals personFdingd "ageroved criminsd and ol ey Inghutions Yeu tan

- Froquertly Odoed Gumstizs
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o sadrchfor and scledroievant pry Instrurtions
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PhaRs THa Drograem S50 e
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CAIUCIENS O0CE MU NAVE (hoSen a0 ens . yOou Can quiccsy 2aapt M 10 Mmsst Ine
18QuUIamente of 3 SEeCAC O COBE
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Multiple print furmats — Alow pnndng jury msbucions s ihe raddons sogepage
format (Rade 201, on Los Angeles Counly Forma 1TEVATT, o1 na bootie! cortalning
rernentalv aranged Insrudions 13 of conlerts and Separdie duposition able

Edtng leatures — Spell checker, auto-pupuiating 2 sleciad Insrutions with siored case
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Figure 2-3. Jury Instruction Selector Help system

Altematively, to openit at the topic that pertains to the active tab or window, click the window or
dialog box's 2 I Help button.
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Figure 2-4. Help button on a window

Oncethe Help system s open, you can freely navigate it with any of the following techniques.

Table 2-2. Techniques for using the comprehensive Help system

Feature
Contents tab
Index tab
Search tab

Favorites tab

‘
Hide | Show

| ¢

Previous | Next
= =
Back | Forward
_ Print |

"You are here"
breadcrumb links

Links in topics

"Send feedback"
link

Used to
Select a topic from a table of contents.
Select a topicfrom a list of keywords.

Search for specific text within the entire Help system, which is especially useful when
the subject you are interested in may be covered in different topics.

Add topics to your list of favorite topics. To add atopic, navigate to it, switchto the
Favorites tab, and click Add (at the bottom of the tab).

Hide or show the navigation pane (the tabs).

Display, respectively, the previous topic and next topic, relative to the currently
displayed topic. In this way, you can step up and down the table of contents.

Display, respectively, the last topic you visited and the next topic you visited.

Print the topic or set of topics selected in the Contents.

See at a glance where the current topic is located in the Help system. Click a link to
select another topic in the same breadcrumb path.

Jump torelated topics.

Help us improve the Help system. Just click the Send feedback about this Help topic link
at the upper right corner of the Help window to send us e-mail about the currently
displayed topic.

Close the Help system.

Define the default district, court, and firm

Before creating instruction files, take the time todefine the defaultdistrictand court, as well as
default firm (attorney information). By defining these items, you will save yourself the trouble of
typing in this information for each instruction file you create. (You can always override these defaults
whenyou set up case-specific information. See "Setup the court and attorney," page 43.)

To define the default district and court and the d efault attorney information

1. Click | Options on themain toolbar, or choose Settings > Options.
The Options window opens atits Courts & Attorney tab.

18
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Courts & Atomey | Diessy | Boot Chapters | Alerte | Omer |
Ceurt Location
g o

il

2. Toenterthe default districtand court, do the following:

a. Inthe Court Location section, click District and Court to open the Edit District and
Court window.

B Dictrct sl Cocy

District snd Court detesls
District and Court Line T+ ||

District and Court Line 2 [

Disinct and Court Line 3 |

(o ] o | 3

b. Completethe fields as needed, and thenclick OK to save and close.

3. To enter the default firm, do the following:
a. Inthe Attorney Information section, complete the fields as needed.

b. To enterthe fimm's address, click Address to open the Edit Address window.

—Adarsss oealls
Street: ||
City: [
State [
Zip cade T
I P

c. Click OK to save andclose.

4. Iffinished with the Options window, click OK to save and close.
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Turn off the Startup Options window

By default, the Startup Options window opens when you start up Jury Instruction Selector. It offers a
quick way to create a new instruction setor to open an existing instruction set.

—Startup Optians

, O Crests 8 new instruction set

@ @ Openan axstngset

More Fles ~
Ci\Program FriesVWeet,... WeerinatructionLizt2000. 31 D

C\Proaram FlesWesnh  \seTEMPZS is I
‘ mw 3

oK I Cancel | _",

Figure 2-5. The Startup Options window

If you'd prefer not to see this window, you can easily turn this feature off. (You can easily turnit back
on if you laterchangeyourmind.)

To turn off the Startup Options window
1. Click | Options on themain toolbar, or choose Settings > Options.
The Options window opens atits Courts & Attorney tab.
2. Switch to the Alerts tab and clear the Display Startup Options window check box.

Courts B Attomey | Disslay | Bock Chaoters  Alerts | other |
Information and Alerts

v Crsplay Judoal Courci of Calformia copynight nobice before apening a fie

[ Digplay access insructors before conrecling o wesdaw.com

[¥ Wam me when my edits wil remove suto-popuate capatiity fom sectons of text
[ Wam me when ed fng parsonal ins fructons

(¥ Wam me when Remove Bracket Charsct=rs" = tumned onin the Prot Tao

[ o« | coenl _9]

3. Click OK to saveandclose.
The next timeyou start up the program, the startup options will not appear.
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Set the default save location
You can set the default location where yourjury instruction files and print-to-file jobs will be saved.

NOTE: If you are running a workstation installation of the program, the default save locationwas
probably already set up by your network administrator. You may wantto check with the
administrator before changing the save location.

To set the default save location

1. Click | Options on themain toolbar, or choose Settings >Options.
The Options window opens.

2. Switch to the Other tab.

3. In the Default Save/Load Location section, click Choose Location to open the Browse For
Folder window (not illustrated). Browse to or make a new folderto use as the defaultsave
location and click OK.

The path of the location you selected appears in the Default Save/Load Location box.

Print to File

DafautFle Type  |Vcmsoft Word Document v
[ Always open documents after saving

Flle Recovery
|7 Ensble Fi= Recoveary

o= '-"lf ,'«‘,.I-..f

Default Save/Load location:

[cwemwta‘oocuma Chooes Location... l

o | o | =

4. Click OK to save andclose.

Turn on File Recovery

With the File Recovery feature (formerly called Auto Save), you can have Jury Instruction Selector
automatically save a recovery file at regularintervals. In the event that the program exits
unexpectedly, the program will promptyou to open the recovery file the next time you startup the
program.

Usethe following procedureto tum on File Recovery.
To turnonFile Recovery

1. Click | Options on themain toolbar, or choose Settings > Options.
The Options window opens.
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2. Switch to the Other tab.

3. Inthe File Recovery section, selectthe Enable File Recovery check box, and then type or select
the number of minutes (from 1to 10) after which you want the open instruction file to be saved
automatically.

Print to File

DefautFleType  |Wcrosoft Word Documert v
[ Always open documeants after saving

File Recovery
[ Ensble Fi= Recovary

Default Save/Load location:

[CwasrwtsiDocumenta Chooes Location... I

T o | e B

4. Click OK to saveandclose.
Until you turn the feature off, Jury Instruction Selector will automatically update the recovery
file every n minutes that you selected. When it does, you will see Recovery File Saved in the
status bar of the Jury Instruction Selector window.

[Civil Recovesy File Saved,

Set display options

With the display options, you can control how jury instructions appearin Jury Instruction Selector.
Experiment with the settings to suit your preferences.

Toset displayoptions

1. Click | Options on themain toolbar, or choose Setting > Options.
The Options window opens.

2. Switch to the Display tab.
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g

Case information Tab

Courte 3 Attoney sy | Book Chiapters | Alerte | Other |

=)

[T =gnignt case niarmation feids that appear In the salsciad nasirucions

Jury Instructions Tab

@ cacl Al
F CALCRM (™ CALINC

Choose ihe display gize of tha inetruction text
 Smal {~ Large

[T Sort PersonalInstructions by number

Chooae which 8e1 of natructens to deplsy first

View & Edit Windows

[V Hghbght changes n nstruchon text
[V Show all case infermation in bokd

= ]

Cancel I

B

3. Set the options as desired.

Case Highlight case

Information  information fields

Tab that appear in the
selected
instructions

Jury Choose which set of

Instruction instructions to

Tab display first
Choose the display
size of the
instruction set

View & Edit  Highlight changes

Windows in instruction text

Show all case
informationin bold

4. Click OK to save and close.

Set up chapter defaults

Select to highlight on the Case Information tab's Party Types,
Acts, Dates, Items & Locations, and Miscellaneous pages any
auto-populate field (a field that can be replaced with entered
case information) that can be found in the Selected Instructions
in the open instruction file. This is a handy way to tell which
fields you need to complete. (For information on the Case
Information tab and its related pages, begin with "Case
Information tab," page 42.)

Select which set of instructions (e.g., BAJl, CACI) you want to
appear first on the Jury Instructions tab's Master Instructions
page. (See "Master Instructions page," page 54.)

Select the size of instruction text displayed on any of the pages
of the Jury Instructions tab. (For information on the Jury
Instructions tab and its related pages, begin with "Jury
Instructions tab," page 54.)

Select to use yellow highlighting to show the differences
between original instruction text and any changes (e.g., manual
edits, auto-populated edits, etc.) in Selected Instructions
opened for editing. (For more information on editing Selected
Instructions, begin with "Select and edit instructions for your
instruction file," page 61.)

Select to use bold to show case information in Selected
Instructions opened for editing.

This section describes how to work with the chapter defaults associated with the Booklet print format.
You can modify the chapter defaults to suit your preferences.

Formore information on the Booklet format, including sample pages, see "Bookletformat," page 87.
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About chapter defaults

A standard format for submitting approved instructions to a jury is the Booklet format, inwhich
instructions are organized into chapters. By default, everyinstruction in Jury Instruction Selector is
assigned to a specific chapterof the Booklet format, based on its instruction number. For example,
civil instructions numbered in the 100 series are assigned to a chapter called PRETRIAL, whereas civil
instructions inthe 3500 series, which pertain to issues of eminent domain, arewithin a chapter called
EMINENT DOMAIN. Within each chapter, the instructions are arranged numerically.

You can modify the chapter defaults to suit your preferences.

Jury Instruction Selector differentiates between chapters of civil instructions and chapters of criminal
instructions. Thefollowing tables outline the chapters as defined at the program's installation.

Table 2-3. Default chapters of civil instructions

Chapter FromInst. Up tolnst.
# #
GENERAL INSTRUCTIONS 0.05 2.00
GENERAL INSTRUCTIONS 1.00 2.00
EVIDENCE AND GUIDES FOR ITS CONSIDERATION 2.00 3.00
NE GLIGENCE —CONTRIBUTORY NE GLIGE NCE —CAUS ATION 3.00 4.00
TORT LAW--SPECIAL DOCTRINES 4.00 5.00
MOTOR VEHICLES 5.00 6.00
OTHER NEGLIGENCE ACTIONS 6.00 7.00
INTENTIONAL TORTS 7.00 8.00
OWNERS, OCCUPANTS OR LESSORS OF LAND 8.00 9.00
PRODUCTS LIABILITY 9.00 10.00
CONTRACTUAL RELATIONSHIPS 10.00 11.00
STATUTORY ACTIONS 1.00 12.00
MISCELLANEOUS ACTIONS 12.00 13.00
VICARIOUS RESPONSIBILITY 13.00 14.00
DAMAGES 14.00 15.00
CONCLUDING INSTRUCTIONS 15.00 16.00
FORMS OF SPECIAL VERDICTS AND JUDGMENTS ON SPECIAL 16.00 17.00
VERDICT
ANNOTATIONS TO CACI 17.00 18.00
PRETRIAL 100 200
EVIDENCE 200 300
CONTRACTS 300 400
NEGLIGENCE 400 500
MEDICAL NEGLIGENCE 500 600
PROFESSIONAL NEGLIGENCE 600 700
MOTOR VEHICLES AND HIGHWAY SAFETY 700 800
RAILROAD CROSSINGS 800 900
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Chapter FromInst. Up tolnst.
# #
COMMON CARRIERS 900 1000
PREMISES LIABILITY 1000 1100
DANGEROUS CONDITION OF PUBLIC PROPERTY 100 1200
PRODUCTS LIABILITY 1200 1300
ASSAULT AND BATTERY 1300 1400
FALSE IMPRISONMENT 1400 1500
MALICIOUS PROSECUTION 1500 1600
EMOTIONAL DISTRESS 1600 1700
DEFAMATION 1700 1800
RIGHT OF PRIVACY 1800 1900
FRAUD OR DECEIT 1900 2000
TRESPASS 2000 2100
CONVERSION 2100 2200
ECONOMIC INTERFERENCE 2200 2300
INSURANCE LITIGATION 2300 2400
WRONGFUL TERMINATION 2400 2500
FAIR EMPLOYMENT AND HOUSING ACT 2500 2600
CALIFORNIA FAMILY RIGHTS ACT 2600 2700
LABOR CODE ACTIONS 2700 2800
WORKERS' COMPENSATION 2800 2900
FEDERAL EMPLOYERS' LIABILITY ACT 2900 3000
CIVIL RIGHTS 3000 3100
ELDER ABUSE AND DEPENDENT ADULT CIVIL PROTECTION ACT 3100 3200
SONG-BEVERLY CONSUMER WARRANTY ACT 3200 3300
UNFAIR PRACTICES ACT 3300 3400
CARTWRIGHT ACT 3400 3500
EMINENT DOMAIN 3500 3600
CONSPIRACY 3600 3700
VICARIOUS RESPONSIBILITY 3700 3800
EQUITABLE INDEMNITY 3800 3900
DAMAGES 3900 4000
LANTERMAN-PETRIS-SHORT ACT 4000 4100
BREACH OF FIDUCIARY DUTY 4100 4200
UNIFORM FRAUDULENT TRANSFER ACT 4200 4300
UNLAWFUL DETAINER 4300 4400
TRADE SECRETS 4400 4500
CONCLUDING INSTRUCTIONS 5000 5100
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Table 2-4. Default chapters of criminal instructions

Chapter FromInst. Up tolnst.
# #

GENERAL INSTRUCTIONS 0.05 2.00
GENERAL INSTRUCTIONS 1.00 2.00
EVIDENCE AND GUIDES FOR ITS CONSIDERATION 2.00 3.00
CULPABILITY FOR CRIME 3.00 4.00
EXEMPTIONS AND DEFENSES 4.00 5.00
GENERAL PRINCIPLES OF JUSTIFICATION 5.00 6.00
ANTICIPATORY AND ACCESSORIAL CRIMES 6.00 7.00
CRIMES AGAINST THE ADMINISTRATION OF GOVERNMENT 7.00 8.00
CRIMES AGAINST LIFE 8.00 9.00
CRIMES AGAINST SECURITY OF PERSON 9/00 10.00
SEX CRIMES 10.00 11.00
CRIMES AGAINST PUBLIC HEALTH, SAFETY AND WELFARE 12.00 13.00
CRIMES AGAINST PROPERTY 14.00 15.00
CRIMINAL WRITINGS 15.00 16.00
MISDEMEANOR INSTRUCTIONS 16.00 17.00
CONCLUDING INSTRUCTIONS 17.00 18.00
ANNOTATIONS TO CALCRIM 18.00 19.00
PRETRIAL 100 200
POST-TRIAL: INTRODUCTORY 200 300
EVIDENCE 300 400
AIDING AND ABETTING, INCHOATE, AND ACCE SSORIAL CRIMES 400 500
HOMICIDE 500 800
ASSAULTIVE AND BATTERY CRIMES 800 1000
SEX OFFENSES 1000 1200
KIDNAPPING 1200 1300
CRIMINAL THREATS AND HATE CRIMES 1300 1400
CRIMINAL STREET GANGS 1400 1500
ARSON 1500 1600
ROBBERY AND CARJACKING 1600 1700
BURGLARY AND RECEIVING STOLEN PROPERTY 1700 1800
THEFT AND EXTORTION 1800 1900
CRIMINAL WRITINGS AND FRAUD 1900 2100
VEHICLE OFFENSES 2100 2300
CONTROLLED SUBSTANCES 2300 2500
WEAPONS 2500 2600
CRIMES AGAINST GOVERNMENT 2600 2800
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Chapter FromInst. Up tolnst.
# #

TAX CRIMES 2800 2900
VANDALISM, LOITERING, TRESPASS, AND OTHER MISCELLANEOUS 2900 3000
OFFENSES

ENHANCEMENTS AND SENTENCING FACTORS 3100 3300
DEFENSES AND INSANITY 3400 3500
POST-TRIAL: CONCLUDING TABLES 3500 3600

Open the chapter defaults for modifying

Usethe following procedureto access the chapterdefaults for the Bookletformatso thatyou can
modify them.

To access the chapter defaults

1. If necessary, open a case of the type (e.g., civil or criminal) whose chapter defaults you want to
access and modify.

2. Click | Options on themain toolbar, or choose Settings > Options.
The Options window opens.

3. Switch to the Book Chapters tab.

-
|G RAL WSTRUCTINS =

1.00 2.00 | GENERAL INSTRUCTIONS

200 3.00 'EVIDENCE AND GUIDES FOR ITS CONSIDERATION

300 200 | NEGLGENCE—CONTRIBUTORY NEGLIGENCE—CAUSATON

400 500 [ TORT LAV/=SPECIAL DOCTAMES

500 5.00 MOTOR VERICLES

600 7.00 |OTHER NEGLIGENCE ACTIONS

700 &.00 | NTENTIONAL TORTS

800 5.00 |OWNERS, OCCUPAKTS OR LESSORS OF LAND

9.00 10.00 \PRODUCTS LIABILITY

|10 00 11 00 :f'ﬂlﬂ'uﬁf‘fl'lﬂ SF1ATWOMCHIDS =

Edt Chapler Add Chagler ] Dekete Chagter | Resiocs Defauts |

o | oo | K

You are now ready to modify the default chapters.

Add default chapters

Use the following procedure to add a default chapter to the Booklet template and identify the
chapter's contents (by range of instruction numbers). For example, you might wantto create a
chapter that will contain Personal Instructions (if you've established sequential numbers for them).
The program will automatically position the new chapteramong the other chapters based on its
starting instruction number.
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NOTE: Regarding the range of instruction numbers in a chapter, the starting instruction will be
included in the chapter, while the ending instruction will be excluded from the chapter. The ending
instruction is actually the point before which the chapterwill end.

To add a default chapter to the Booklet template
1. Open the chapterdefaults (see previous page).

2. On the Options window's Book Chapters tab, click Add Chapter.
The Add Chapter window opens.

NOTE: Yellow in a field means thatthe field does not contain a valid entry. Whenyou first
add a chapter, the fields will be blank, and therefore, technically, invalid. Asyou set up the
new chapter, pay attention to the Help Text that will appear at the bottom of the window for
guidance.

"2kt Chapter 7

Entsrthechaptar (informsiion belaw
~~Chapter Information

Start Instruction ' 'I

End Inztruction I 'I
Chapler Title I
Helg Text

[ o | conca | 2|

3. Inthe Start Instruction and End Instruction boxes, type or selectthe numbers of the chapter's
starting instruction and ending instruction.

NOTE: The drop-down lists show all of the Master Instructions as well as any Personal
Instructions. To quickly jump to a specific instruction in a list, type the first few digits/letters
of its instruction number.

4. Inthe Chapter Title box, enter the title. (The program does not require that the title bein all
caps, butyou might prefer to do so for consistency with other chaptertitles.)

5. Click OK to save and close.
The new chapter is added to the list of chapters.

TIP: Check the list to verify that the new chapter's range of instructions does notoverap with
those of the chapterimmediately preceding it. If there is any overlap, the ovellapping
instructions will end up appearing in both chapters. To correct this, edit the preceding
chapter's ending instruction number accordingly. (See "Edit default chapters," below.)

Edit default chapters
You canedit a default chapter's title and the range of instructions the chapter contains.

NOTE: Regarding the range of instruction numbers in a chapter, the starting instruction will be
included in the chapter, while the ending instruction will be excluded from the chapter. The ending
instruction is actually the point before which the chapterwill end.

To edit a default chapter of the Booklet template
1. Open the chapterdefaults (see previous page).

2. On the Options window's Book Chapters tab, click Edit Chapter.
The Edit Chapter window opens.
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Enterthechapterinformation below
Chapler Information

Start [nstructia n.{o s¢ 'i
End Instruction !2 00 vl

Chapter Title:  |GENERAL INSTRUTTIONS

[ ok | conea | 2|

NOTE: As you edit the chapter, if afield tums yellow, it means yourentry is notvalid. Pay
attention to the Help Text that will appear at the bottom of the window for guidance.

3. In the Start Instruction and End Instruction boxes, type or selectthe numbers of the chapter's
starting instruction and ending instruction.

NOTE: The drop-down lists show all of the Master Instructions as well as any Personal
Instructions. To quickly jump to a specific instruction in a list, type the first few digits/letters
of its instruction number.

4. In the Chapter Title box, edit the title as desired. (The program does not require that the title be
in all caps, butyou might prefer to do so forconsistency with other chaptertitles.)

5. Click OK to save andclose.

TIP: Check the list to verify that the chapter's range of instructions does not overlap with
those of the chapterimmediately preceding it. If there is any overlap, the overlapping
instructions will end up appearing in both chapters. To correct this, edit the preceding

chapter's ending instruction number accordingly.

Delete default chapters

When you delete a default chapter from the Booklet template, you remove the container for a range of
instructions. For instance, wereyou to remove the chapter containing any of the instructions in the
100 series, no instructions with any of those numbers, evenif selected in the instruction file, will

appear in the printed booklet.
Todelete a chapter from the Booklet template
1. Openthe chapter defaults (see page 27).
2. Select the chapter you want to delete and click Delete Chapter.
3. Inresponse to the confimation message, click OK.
(Cortum =

6 Do you want to delete chapten

GEMERAL INSTRUCTIONS
Instructions 0 50 to 2.007

oK ] concd | el
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Restore chapter defaults

You may find that you'd like to restore the Booklet template to its default chapter settings. You can
actually restore back to last saved defaults orto the defaults at program installation.

To restore the default chapters

1.

Access the chapter defaults. (Seepage 27.)

2. On the Options window's Book Chapters tab, click Restore Defaults.

The Restore Defaults window opens.

Chooss which set of defaultzto restore
Hots: Current chapler tlles will be 1ost

~Chapter Tie
' Sgved Defsults

" Frogram Dsfaulis

[ ok | conce | 2

3. Select the desired option, Saved Defaults or Program Defaults.

4. Click OK to save andclose.

Access Westlaw from within Jury Instruction Selector

As you use Jury Instruction Selector, you can quickly access Westlaw material. A connection to the
Internet must already be active.

To access Westlaw from within Jury Instruction Selector

1.

2.

Click _"ﬂ Westlaw Research on the main toolbar, or choose References > Westlaw Online
Research.

If this is the first time you have attempted to access Westlaw from within the program, an
information message appears.

!‘ , Yaoumusihavean active conneclion lothe internet and a validWest aw

password to continue. fyou donothavewesiisw.com access pleass
call the sales degartment a1 500.248 2443 for corporaie sales and
800 762 5272 torlaw firm and Government sales

7 Inth=fdure donot show this messag=

i | ]

If you do nothave access to Westlaw, be sureto call one of the telephone numbers in the
messageto request access. Click OK to dismiss the message.

NOTE: To keep this message from appearing in future, select the In the future, do not show
this message check box. (If you decide laterto tum this message back on, choose Settings >
Options. On the Options window's Alerts tab, select the Display access instructions before
connecting to westlaw.com check box.)

On the Westlaw Online Research window that opens, find the subject area you are interested
in, and click to expand it to seethe resources it contains.
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Selact a Westlaw databasebelowandclick Opento doadotional research,
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3. Select the material you want to view on Westlaw and click Open.
Yourdefault web browser launches (if notalready running) and opens the Westlaw Sign-on

Page.

4. Followyourstandard practiceforsigning onto and using Westlaw.
Afteryou sign on, you will be directed to the relevant material in Westlaw.

View reference materials

Foryour convenience, Jury Instruction Selector includes reference materials that you can access at
any time. Which reference materials are available for viewing depend on the type of case (civil or
criminal). These reference materials are provided as PDF documents, viewable with a PDF reader
such as Adobe Reader. To view any of these materials, use their corresponding commands on the
References menu, such as References > Tables > Life Expectancy Table. Your default PDF reader
starts up, and you can thenview the document on screen or print it.

Table 2-5. Civil reference materials

References menu
command

CA Rules of Court, Rules
2.1050, 2.1055

BAJI Appendices

CACI Preface

Reference

Amendments to the California Rules of Court specific to Rule 2.1050 (formerly
Rule 855) and Rule 2.1055 (formerly Rule 229), effective January 1, 2007.

The following appendices of the BAJl print version:

o Appendix C, "California Evidence Code"

Appendix D, "Special Verdicts"
Appendix E, "BAJl Master List"

The following material from the CACI print version:

Members list of the Judicial Coundl Task Force on Civil Jury Instructions
Publisher's Preface and Preface to CACl Updates

Guide for Using Judicial Council of California Civil Jury Instructions
(CACI)

Westlaw Electronic Research Guide
Related Products from West
Table of derived, renumbered, replaced, and revoked instructions
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References menu

command

Tables

BAJI-CACI
Conversion
Table

CACI No.
1700 Tables

CACI No.
3100 Tables

CACI No.
3900 Tables

Disposition
Table

Finding Aids

Life
Expectancy
Table

Present Value
Table

Reference

Two tables listing CACl instructions and their directly corresponding and other
related BAJIl instructions and vice versa.

The following tables from CACI No. 1700:
o Table A, "Defamation Per Se"
o Table B, "Defamation Per Quod"

The following table from CACI No. 3100:
o Table A, "Elder Abuse: Causes of Action, Remedies, and Employer
Liability"
The following tables from CACI No. 3900:

e Worksheets A and B from CACI No.3904B, “Use of Present Value
Tables"

A blank Disposition Table form that may be printed for use when planning
instructions to be included in an instruction set.

The BAJl and CACI Tables of Cases, Tables of Statutes, Key Digest Tables, and
Indices.

A table of life expectancies for individuals living in the U.S. beginning at
specific age intervals and for specific populations. From the National Center for
Health Statistics.

Tables of present values and compound discounts with which you can calalate
a present value which, when invested at a specific rate of investment return, will
pay at the end of each year a determined amount for a specific number of
years.

Table 2-6. Criminal reference materials

References menu

command

CA Rules of Court, Rules
2.1050, 2.1055

CALJIC Appendices

CALCRIM Preface

Reference

Amendments to the California Rules of Court specific to Rule 2.1050 (formerly
Rule 855) and Rule 2.1055 (formerly Rule 229), effective January 1, 2007.
The following appendices of the CALJIC print version:

o Appendix A, "Criminal Law — Sua Sponte Instructions"

o Appendix B, "Reasonable Doubt — The California Experience"

o Appendix C, "Lesser Offenses to the Offense Charged"

o Appendix D, "The Birth, Life, and Death of Lesser Related Offenses"

o Appendix E, "CALJIC Master List"

The following material from the CALCRIM print version:
o Members list of the Judicial Coundl Task Force on Civil Jury Instructions
e Publisher's Preface and Preface to CALCRIM Upd ates

o Guide for Using Judicial Council of California Criminal Jury Instructions
(CALCRIM)

o Westlaw Electronic Research Guide
o Related Products from West

32

California Jury Instruction Selector User Guide (Version 6.1)



Chapter 2. Getting Started with Jury Instruction Selector
Exit Jury Instruction Selector

References menu Reference
command
Tables CALJIC- Two tables listing CALJIC instructions and their directly corresponding and other
CALCRIM related CALCRIM instructions and vice versa.
Conversion
Table
Disposition A blank Disposition Table form that may be printed for use when planning

Table instructions to be included in an instruction set.

Finding Aids The CAUIC and CALCRIM Tables of Cases, Tables of Statutes, and Indices, as

well as the CALJIC Key Digest Tables.

Life A table of life expectancies for individuals living in the U.S. beginning at
Expectancy specific age intervals and for specific populations. From the National Center for
Table Health Statistics.

Exit Jury Instruction Selector

To exit Jury Instruction Selector

1. Choose

Nz
File > Exit, or click on the titlebar.

If an instruction setis openandyou have notyetsaved recent changes, a warning message
appears prompting you to save.

A

=S|

The selected instructions are not saved.
Seve the current set?

I No I Cancel I Help |

2. Respond appropriately to the waming.

The pro

gram exits.
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CHAPTER 3. MANAGING
INSTRUCTION FILES

This chapterfocuses on managing instruction files (both instruction sets and instructions lists). It begins by defining the
difference between instruction sets and instruction lists. It then o ffers step-by-step procedures for managing these sets
and lists (starting new o nes, opening existing ones, saving, and so forth).

About instruction sets and iNSTrUCTioON LiStS - v o v oo e e e e e ee e e emaeamremmamam s 35
O R TR g o R | e s e e R e A R R I A S N e e e S A A e 35
Save a NeW INSErUCTION fIle .. ... e e e e e e e e e e nan 36
Save aninstruction file under a different NAMe - - - oo oo oo S S s 37
Save an instruction file of one type as the other type ... ..o e 37
Open an inStruction file «zce s e s s Sl S Sl s e S0 i S e FEa LSS a e a S S ST S aa S Sl sa 38
Closeaninstructionfile ... ... ... ... N S S B e e R e L B R I A L S e e s 39
Delete aninstruction file ssocczamess sassa o e G, s e (o A S S B L S e s S B 39

About instruction sets and instruction lists

You can save yourinstruction files in two formats:

o Instruction set — This file format(.jis) contains case-specific data (such as the names of
persons and entities, dates, acts, and so forth), the collection of jury instructions that you
select (thereby called Selected Instructions), and all of your customizations to those
instructions. When you need to prepare jury instructions for a particular case, you will save
yourwork in this format.

o Instruction list — This file format(.jil) does not include any case-specific data or any edits you
may have made to instructions. Instead, it contains only the Master versions of those
instructions. You might like to save an instruction setas aninstructionlisttouseas a
template.

Aninstruction setcan besaved as aninstruction list, and viceversa. Butitis important to remember
that if you saveaninstructionsetas an instruction list, all case-specific data and customizations will
be lost.

Unless otherwise noted, the term instruction file means either format.

Create an instruction file

Use the New featureto create a newinstruction file.

If aninstruction fileis already open, you don'thave to closeit first. If the open file has not yet been
saved, you will be prompted to saveit before a new fileis started.
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Save a new instruction file

To start a new instruction file

1. Click D | New on the main toolbar, orchoose File > New.
The New Instruction Set window opens.

"N Insbraction Set.
Case Type

@ Civil

" Criminal

oK | Cancel I

2. Select the type of caseyou will prepare jury instructions for and click OK.
The Judicial Council of California Copyright Notice window (not illustrated) opens.

3. Ifyou prefernotto seethe copyright noticein future, select the In the future, do not show this
message check box and click OK.
A new instruction file has now been started. Notice that the type of case, such as "Criminal,"
appears in the application window's title bar and status bar.

BB ury Instruction Seector Tor Windows {Criminal [Instructi
Fle Instruchon Toois References Settngs Help
N B » | & e

et lA_wr e Veile i lava |

ECrimiml Instructions Not Saved. j

The new instruction fileis now ready for you to begin working with it. (Before continuing, you may
want to save the new file. See "Save a new instruction file," below.)

Save a new instruction file

Use the Save feature to save a new instruction file, whether as an instruction setorinstruction list.
Tosave a new instruction file

1. Click n | Save on themain toolbar, orchoose File > Save.
The Save Instructions window opens, listing previously saved instruction files. By default, the
window assumes thatyou will saveyourfileas aninstruction set
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Seve in: I W s

v « @& exE-

Ao N;me' Date modif.. Type Size
"’*{m jﬂfﬁeckrrv S(hule.,is

l B2 WnghtVSmith s
Desitop

File name: ' Save

[
[l

Led Lo

Saveastpe:  [hsnicton Set

N

. (Optional) Navigate to a different Save in location.

w

. In the File name box, type a name for the instruction file.

»

From the Save as type drop-down list, select either Instruction Set or Instruction List, depending
on the type you want.

. Click Save.

Ul

6. Ifyou elected to savethe new fileas aninstruction list, a warming message appears. Click Yes
to confirm.

TIP: Notice that the Save button on thetoolbaris now "grayed out," as in H I, toindicate
that the file has been saved. As soon as you changesomething in the file the button will turn

orangeagain, asin g I By noting this color change, you can always see ata glanceif you
need tosaveyourfile.

Save an instruction file under a different name

Usethe File > Save As commandto save aninstruction fileunder a different name whileretaining
theoriginal instruction file.
To save aninstruction file under a different name

1. Choose File > Save As.
The Save Instruction Set window opens, listing previously saved instruction sets. (This
window is similar to the Save Instructions window.)

2. (Optional) Navigate to a different Save in location.
3. Inthe File name fidd, type a new name forthe instruction file.

4. Click Save.

Save an instruction file of one type as the other type

Usethe File > Save As command to save an instruction fileof one type (e.g., instruction set) as the
other type (e.g., instruction list). Forexample, saving an instruction setas an instruction list is useful
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Open aninstruction file

if you wantto createa templateforusein future cases.

IMPORTANT! Whenyou save aninstruction setas an instruction list, all of the case-specific data
will be discarded, as well as any edits you made to the text of Selected Instructions. Instructions will
revert to their original Master Instruction texts.

To save an instruction file of one type as the other type

1.

ChooseFile > Save As.
The Save Instruction Set window opens, listing previously saved instruction sets. (This
window is similar to the Save Instructions window.)

(Optional) Navigate to a different Save in location.

In the File name field, type a new name for the instruction file.

From the Save as type drop-down list, select either Instruction Setor Instruction List,
depending on the type you want.

Click Save.

Ifyou elected to save as aninstruction list, a waming message appears. Click Yes to confirm.

Open an instruction file

Use the Open feature to open an instruction file.

If another instructionfileis already open, you don'thaveto closeit first. If theopen filehas not yet
beensaved, you will be prompted if you want to save it before opening anotherfile.

Toopen aninstruction file

=
1. Click I3"' Open on themain toolbar, orchoose File > Open.
The Open Instructions window opens, listing previously saved instruction sets and lists.

2.

Look in: I | User
&y Name Date modff...
2 0}’, éﬁed:elv Schultzyis )
B0 Instruchonl st 2000 !
. B Wnght\Smithpis
Degdop BB WnghtVSmith_AsAListyil
0
Nita
Computer
-
Retwork

| By Er
Type Size

Fie rame: l

3 I T

Flesoftype. [l by Iretruceon Selecior Flee (4 "8} _v) Cancel |

If there are many files, you may preferto filterthe list to show files of one type only. From the
Files of type drop-down list, select Instruction Sets or Instruction Lists.

3. Selectthedesired file and click Open.
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Closeaninstmctionfile

NOTES:

(1) If the instruction set had been saved before any instructions were selected for it, the
message "No instructions exist in the file" opens. Click OK to dismiss the message.

(2) If you use Jury Instruction Selector on a network, it is possible that another user may have
already opened the file. Inthat case, a waming will alertyou that the fileis already inuse. If
you continue to open the fileg, it will beread-only.

(3) If the official versions of any Selected Instructions were updated since the last time the file
was opened, a waming will alert you that there are out-of-date instructions. To update the
instructions, click OK and then proceed to the Jury Instructions tab's Master Instructions
page. You will need to deselectand reselectthe instructions, and you may need to re-edit the
instructions as needed. For more information, see the FAQ "Why do | get a message saying
that instructions areout-of-date?" in the Help system.

Close an instruction file

Use the Close featureto close an instruction file.

To close aninstruction file

1.

"
Click il | Closeon themain toolbar, or choose File > Close.
If you have made changes to the instruction file but have notyet saved them, a waming
message appears.

Respond appropriately to the waming.
The filecloses.

Delete an instruction file

Thereis no "delete a file" featurein Jury Instruction Selector per se. However, you can easily delete an
instruction file either directly from Windows Explorer or right from within the program (as described
below).

Todelete an instruction file

1.

2.

If the instruction file you want to delete is currently open, close it before proceeding.

L]
Click L= | Openon themain toolbar, or choose File > Open.
The Open Instructions window opens, listing previously saved instruction files.

If there are many files, you may preferto filterthe list to show files of one type only. From the
Files of type drop-down list, select Instruction Sets or Instruction Lists.

Right-click the fileyou want to delete and choose Delete.

Inresponse to the confitnation message, click Yes .

. Click Cancel to close the window.
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CHAPTER 4. WORKING WITH CASE
INFORMATION

This chapterexplains how to set up the information that is specific to a case, such as the presiding court, the attorney, the
parties, acts, dates, locations, and so forth. Later, you can auto-populate your Selected Instructions with this information.

About case INformMation - ... 41
Case |NTormation T a0 SR SIS S STTRS . RS S SO S S S S 42
O LI & AL O NIy [a10) e ST et 42
Set up the court and attorNeY . .. .. e e e e e e e e e 43
Parties page Siaa e S i S S s s S S ST o S0 L0 2 S S e s U e ST e T R Dt 43
Set Up the parties S s s s e A S S I L B S A B S S TS S S S B i i 44
Party TYpes pPage s s s s S L T Ly S S S s L e S S S I DL S R R s 46
St Up party by pes oo s i a L T S e e S B s S L R B i S 46
A DA S N o S A S R R e e L N A e P e e e S G i e B 47
SOt U A o o e e A B B e g S T R S R A e S gy 47
Dates page =owmss ot ss s e e S e S e e LA S D PR S e S S £ AL S R S s S S A S 48
Set UP JatS iwre sme smt o o ot s i o e i e B £ P e SR 5 G B S T o e e B e R r 48
[tems & LOCAtIONS PAQE .acmssrmmsmmiusssas Simamntmermiasesssnmeedim Sssmentnn oo s s ms it S s Sko ey 49
Set up items and LOCAtIONS assias samiaessnsies sannssnsse i s s s ss oeis s ss saiesessssssssussssesnsssssss 49
MISCELIANEOUS DAY ittt rotataratormrnzmimiats simim = micio 7585 it b i e b 2 i il oS i 50
Set up Miscellaneous iNfOrMAatioN vuuueeereeereeeessesserssssesssassssssssssssassssssssssssssssassnanes 50
Look up where case information is used in Selected Instructions - ... 51

About case information

Case information consists of all the persons, entities, actions, dates, locations, and other information
that is specific to the case for which you are creating jury instructions. Tosetup caseinformation, you
work on the program's Case Information tab.

Typically you define caseinformation whenyou starta new instruction set, but you can also editand
add caseinformation at any time before printing the completed set of instructions. Infact, you're
likely to add more case information as instructions are added to the instruction set.
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Case Information tab

You manage case information on the aptly named Case Information tab. Along its left panel, the tab
is divided into pages, such as Court & Attorney, Parties, and Acts. Justclicka heading to switchto
the page you want to work with.

Stat Cose Infomnanen | ury Tnstructors | Pint |

Cenrt & Atarasy ‘ Court _‘_['. Attomey

Pates o ey ’ s :
Paty Typus Cage rumber| | Fam rama: |
Acis Trisl date: [tz | || B e |
- rans:
Dates ARkevy [ e |
Diatrict and Coust
lomes & Locatione
I : L
Mezcallanamis dechore: .
. Fas: O
I Enait |
™ Use Droeion Title
Farty type: { _'J

Figure 4-1. Case Information tab, opened at its Court & Attorney page

NOTE: Periodically saveyourinstructionfile as you work.

Court & Attorney page

Use the Court & Attorney page of the Case Information tab to set up information about the court
presiding over the case and the attorney handling the case. Thisinformation will be used to auto-
populate applicable Selected Instructions in the open instruction set.

Table 4-1. Courtfields

Field Description
Casename Enter the name of the case for which you are preparing jury instructions.

Case number Enter the identifying number of the case for which you are preparing jury
instructions.

Trial date Enterthe trial date, or clickll to open a popup calendar from which you can
select a date. The default is today's date.

Judge name Enter the name of the judge presiding over the case.

District and  The district and court where the case is being heard. To enter these items, click
Court District and Court to open and complete the Edit District and Court window
(notillustrated).

Department Type the department handling the case.

Use Division Select this check box to use the division title rather than the department title.
Title
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Table 4-2. Attorney fields

Field Description

Attorney Enter the name of the attorney handling the case.
name

Firm name Enter the name of the attorney's firm.

Bar Enter the attorney's bar number.
number

Address The attorney's address. To enter this address, click Address to open and complete
the Edit Address window (not illustrated).

Telephone Enter the attomey's telephone number.
Fax Enter the attorney's fax number.
Email Enter the attorney's email address.

Party type From this drop-down list, select the party that the attorney is representing, such as
Plaintiff or Defendant for a civil case or People or Defendant for a criminal case.

Set up the court and attorney

To identify the court and attorney information
1. On the Case Information tab, go to the Court & Attorney page.
2. Inthe Court section, complete the fields as needed. (See Table 4-1.)
3. Inthe Attorney section, complete the fields as needed. (See Table 4-2)

Parties page

Usethe Parties page of the Case Information tab to manage information about the persons and/or
entities who are parties in the case. This informationwill be used to auto-populate applicable
Selected Instructions in the open instruction set.

Each party has an assigned role in the case, such as Defendant or Plaintiff, or some other applicable
role such as Expert, Accomplice, or Employer.

From the Parties page, you can add parties, edit parties (including changing their roles), and remove
parties.

Although you might add most of the information about parties when you first begin working on an
instruction set, you can add parties at any time. In fact, you are likely to add parties gradually as
more jury instructions are selected.
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Parties page

Start {Ca3€ (FOMSHEN | Jury Instructors | Print |
Court & Actomey EitRdes | Addraty ] Remcue Party |
Parges Nane Rloks Gerder
Paty Typus

) | Rchard wrght | Peer 1] e
Acis ‘ ' ' '
Dsses
home & Locatione
Mecellanaos
?
Figure 4-2. Case Information > Parties page
Set up the parties

To add a partyto the case
1. On the Case Information tab, go to the Parties page.

2. Click Add Party to open the Party Details window.

Hame " Genger lNone vI
15 1his party a defendant or plainmim?

I 'I Num ber. |1 E [T £xclude from Dafenoant Auts Populs
Avallable Rofes Selected Roles

Actor-first »

ACEDT--28CONG

Anency

AgRn =

Cymuncipaity

Compisnant — Add = l
Condemnor
Conspirator
Copartcpant «Rumave I

Debior
Decedent

Defendant-—=mplyee «~Remova NI l
Defendant—-empbyer

Defendant—enity

Datendant-frat

Defendant—first employer
Defandanl--hosplsl
Defendant--nonsetiing
Defendant--2acond ampoysr o

Hide roles thai arenct inciuded | 0K I Cancel ' ¢ l
r in the Selected Instructons |

3. If adding a defendantor plaintiff, do thefollowing:

a. Enterthe party's name, select the appropriategender, select the party's type (eg.,
Defendant, Plaintiff), and the party's number (e.g., 1, as in Defendant1).

b. Ifyou plan to exclude this party's information when you later auto-populate jury
instructions, selectthe Exclude in Defendant/Plaintiff Auto-Populate check box.

BEST PRACTICE: Why might you want to exclude a party's information from the
Auto-Populate feature? Assume a case involving an employerand employee in which
both aredefendants, but the first person is to be referred to as "defendant" and the
second person as "employee." In this situation, you would want to exclude the
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employee's information when auto-populating instructions. But then assume you
laterselected a new instruction in which both the employee and employerare to be
referred to jointly as "defendants," with both names appearing together. In this
situation, you would come back to the employee's party details, clear the Exclude
check box, and then auto-populate the new instruction.

4. If adding any other kind of party (e.g., Expert, Accomplice, Employer) do the following:
a. Enterthe party's nameand selectthe appropriate gender.

b. From the Available Roles list, select an appropriaterole(s) for this party and click
Add>. (To select multiple roles, use Shift+click and Ctrl+Click.)

NOTE: The roles listed will vary depending on the type of case (civil or criminal).

5. Click OK to save andclose.
The party is now listed on the Parties page.
To edit aparty
1. On the Case Information tab, open the Parties page.
2. Select the party you want to edit and click Edit Roles.

3. On the Party Details window, edit the fields and/orchange the party's role(s), as needed. For
example, to remove (unassign) a role, select it on the Selected Roles listand click <Remove.

4. Click OK to save andclose.

Toremove aparty from the case
1. On the Case Information tab, open the Parties page.
2. Select the party you want toremove and click Remove Party.

3. Click OK to confirm.
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Party Types page

Use the Party Types pageof the Case Information tab to enter general descriptions of parties (such
as "attorney" or "registered nurse") or official titles or job descriptions (such as "Police Officer") that
you will useininstructions. This information will be used to auto-populate applicable Selected
Instructions in the open instruction set.

NOTE: The fields will vary depending on the type of case(civil or criminal).

Tstann  Case Information |ty Instrucsoes | rt

Cour & Alloiney a-gw_m;’

Patws Health-care promder ~type: I

Barty Trpe Do patonfxofssord: [
Officer —trie: l_

Acts ot —

[tes Servie proades: I

tems & Locaticns

Misceollancous

righighe fekds £a) st
N ced 1 the Seected!

Figure 4-3. Case Information > Party Types page

Set up party types

Toset up partytypes
1. On the Case Information tab, go to the Party Types page.

2. Completethe necessary fields. (Click Highlight fields that are included in the Selected
Instructions to see which fields need to be completed.) Leave blank any party type that does
notapply to the case.
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Acts page
Acts page

Usethe Acts page of the Case Information tab to identify the acts and/or crimes that are pertinent to
the case. This information will be used to auto-populate applicable Selected Instructions in the open
instruction set If an actis not applicable to the case, leaveits field blank.

NOTE: The fields will vary depending on the type of case (civil or criminal).

Start  Case Informaticn | vey natrucnces | priee

| Count & Attomey tetEcrore

Panies Actraty: I

Paty Types Gl I

‘ e et r

[ates

ltems & Locations

Mazzilancous

giohs Bk gt e

mcadec] 1 the Seler !

}th:lrc >

2
Figure 4-4. Case Information > Acts page
Set up acts

To set up act information
1. On the Case Information tab, go to the Acts page.

2. Completethe necessary fields. (Click Highlight fields that are included in the Selected
Instructions to see which fields need to be completed.) Leave blank any act that does not
apply to the case.
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Dates page
Dates page
Use the Dates page of the Case Information tab to identify dates that are pertinent to the case. This
information will be used to auto-populate applicable Selected Instructions in the open instruction set.
If a dateis not applicable to the case, leaveits field blank. Also be sure to use the date format
required by the court.
NOTE: The fields will vary depending on the type of case(civil or criminal).
TSt Came Information | ury Instruckors | vt
. Cour 8 Actoiney . Data:
Patws Dote of acodert: I
Paty Types Mot I
' Date oF fing: |
Acts Date of vausoon: I
[ates
tems & Locations
Misceollancous
righighe fekds £a) st
2
Figure 4-5. Case Information > Dates page
Set up dates

Toset up dates
1. On the Case Information tab, go to the Dates page.

2. Completethe necessary fields. (Click Highlight fields that are included in the Selected
Instructions to see which fields need to be completed.) Use the date format required by the
court. Leave blank any date that does not apply to the case.

48 California Jury Instruction Selector User Guide (Version 6.1)



Chapter 4. Working with Case Information
Items & Locations page

Items & Locations page

Usethe Items & Locations page of the Case Information tab to identify any items and locations that
are pertinent to the case. This information will be used to auto-populate applicable Selected
Instructions in the open instruction set. If anitem orlocation is not applicable to thecase, leave its
field blank.

NOTE: The fields will vary depending on the type of case (civil or criminal).

Start  Case Infonmation | vey natrucnces | Pt

Coun & Atlomey feimal: : I

Panies Good: l T
Paty Types et
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ate Productacp:
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Mazzilancous
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mcuadec] 1 the Selecd
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Figure 4-6. Case Information >Items & Locations page

Set up items and locations

To set up infformation about items and locations
1. On the Case Information tab, go to the Items & Locations page.

2. Completethe necessary fields. (Click Highlight fields that are included in the Selected
Instructions to see which fields need to be completed.) Leave blank any item orlocation that
does not apply to the case.
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Miscellaneous page

Use the Miscellaneous page of the Case Information tab to define any remaining, miscellaneous
information needed for the case (e.g., an amount [usually but not always monetary], a description of
damages, a description of a health condition, a status orclass, and so forth). This information will be
used to auto-populate applicable Selected Instructions in the open instruction set.

NOTE: The fields will vary depending on the type of case(civil or criminal).

Tstann  Case Information |ty Instrucsoes | vt
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Figure 4-7. Case Information > Miscellaneous page

Set up miscellaneous information

To set up miscellaneous information
1. On the Case Information tab, go to the ltems & Locations page.

2. Completethe necessary fields. (Click Highlight fields that are included in the Selected
Instructions to see which fields need to be completed.) Leave blank any item or location that
does not apply to thecase.
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Look up where case information is used in Selected Instructions

With the Case Information Lookup feature, you can quickly look up the list of Selected Instructions in

which a particular auto-populate field is used. This featureis available on the Case Information tab's
Party Types, Acts, Dates, Items & Locations, and Miscellaneous pages.

TIP: Before using the Lookup feature, turn on the highlighting to see which fields are used
somewherein your Selected Instructions. Do so by clicking the Highlight fields that areincluded in
the Selected Instructions>> link beneath the page headings at the left of the Case Information tab.

Thelabels that now appearin bold orange lettersindicate those fields that are used somewhere
Selected Instructions. Then use the Lookup feature to see exactly where.

To look up where case informationis used

e Onthe page of the Case Information tab where the field is shown, click the field's label (not
its text box).

The Case Information Lookup window opens, listing the instructions where the field is used.
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This chapterfocuses on working with instructions. It includes procedures for viewing the text and Commentary of Master
Instructions, for finding specific instructions, for selecting instructions for inclusion in an instruction set, and for editing
instructions in various ways. (This chapter does not cover how to create Personal Instructions; see instead Chapter7.)
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About Master, Personal, and Selected Instructions

There are three types of jury instructions in Jury Instruction Selector:

e Master Instructions — The jury instructions provided with their official language and stored in

the program's database. You cannot edit them or remove them from the program. Many
Master Instructions include replaceable fields (call ed brackets and blanks) intended to be
populated with case-specificinformation. All Master Instructions have accompanying
Commentaries that provide authority and can help you decide whetheror not to selectthem
forinclusion in aninstructionfile.

Personal Instructions — Custom instructions that can be selected forinclusion in an instruction
file.

NOTE: This chapter discusses only how to use Personal Instructions as you would a Master
Instruction. Forinformation on creating Personal Instructions, see Chapter 7.

Selected Instructions — Theinstructions that you have selected from the Master Instructions
and Personal Instructions forinclusionin the instruction file. Itis this set of instructions that
will be handed outto thejury, afterreview and comment by the opposing attorneys and the
court You can freely edit the Selected Instructions as the attorneys and courtrequest, and you
can auto-populate the instructions' replaceable fields with case information.

Jury Instructions tab

You work with instructions on the Jury Instructions tab (Figure5-1). Along its left panel, the tab is
divided into pages, such as Master Instructions, PersonalInstructions, and Selected Instructions.
Justclick a heading to go to the page you want to work with.

NOTE: Periodically saveyourinstruction file as you work.

Master Instructions page

The Jury Instructions tab's Master Instructions pagegives you access to the full set of Master
Instructions in Jury Instruction Selector. On this page you will select instructions for inclusion in your
instruction file.

Start | Case Infy [Xury Tnsinacions || print |

Nastsr |

Personal Ingtructions gote ']

Sclacted Instructions Requesied Typz ratrucien | Desorigtos Heoser Frot Tete 2
> IFELMISRY AURDHTONS .
Chapeers/Sort ‘
v tans 101 OVERVEW OF TRIAL | 22007
Rstory ¢ v 102 TAKNG NOTES DURING THE TRIAL | v2m007
tan T0s T WULTRLE PARTES ["azo0s
s e " MON-LERSON PARTY | arz00s
CAI 108 NSLRANCE { 92003
\/ cal 106 EVIENCE ' 27005
3 cag 107 WSS | 4007
J Tag 100 DUTY TO ABDE BY TRAMSLATION PROVIDED N COURT | 412004
AT 109 AENOVAL OF CLANS OR PARTES ! sz002
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Figure 5-1. Master Instructions page of the Jury Instructions tab
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Personal Instructions page

From the Jury Instructions tab's Personal Instructions page, you will select user-defined
instructions known as Personal Instructions forinclusionin your instruction file, exactly as you would
a Master Instruction. From here you can also add, edit, and delete Personal Instructions. (Creating
Personal Instructions is not covered in this chapter; instead, see Chapter7.)

“Gtant | Cae Informotion [ IRIFLEERE P |
Mastar nstructons J 4] m G G ‘;] a3 | é “ e l
i wuod b tionn :j BJ W
Selectad inatrictions Requesied hs¥uetn . - Destsplin Heade!
Chapters’Son i
USERB
Hstory USERG

Figure 5-2. Jury Instructions > Personal Instructions page

Selected Instructions page

The Jury Instructions tab's Selected Instructions page lists only those Master Instructions and
Personal Instructions that have been selected for inclusionin your instruction file. From this page,
you will access features forediting the Selected Instructions for the case for which you are preparing
jury instructions.

Mastar nstrictions JoonER 535 | & M e
Personal Instructions T 1 T 1
jodd lustr i tioon | | Reauestea | Type Retucton | Descrpmon Header Frist Cae
] JURY NGT EPECULATE AS-TD RENOVAL OF CLANS 08

(raptars/Son
J BAll 1550 FORM OF SPECIAL VERDICT-NTENTIONAL 2002

i \/ cas 10 FRELWIARY ATNONMONS 122087
V] caD T T OVERVEW OF TRIAL | 2m007
7 oo @ | TAKNC NOTES DURNG THE TRIAL 1a087
v oo 109 EVDENCE 212005
v CAQ m WITHESSES 42007
7 cagl 100 DUTY TO ADDE DY TRANSUATION FROVEDED W COURT  4/2004

Figure 5-3. Jury Instructions > Selected Instructions page

Chapters/Sort page

The Jury Instructions tab's Chapters/Sort page offers features forfine-tuning the orderin which your
Selected Instructions will print. (In fact, the order of instructions on this page controls the orderin
which instructions are listed on the Print tab's Choose Instructions page.)
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If you will be printing yourinstructions in Booklet format, you can also use the Chapters/Sort page
to edit the titles of chapters for the particular case you'reworking on, in effect, overriding the chapter
defaults. (If you will not be using the Bookletformat, you can ignore the chaptertitles.)

.........

Master netruchions oo B B & A otk |

Persongl Instruchons V| & <

Solacted Instructions

YIY HOT SFECULATE | SENERAL METRUCTIONE
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cAC 02 T TAKNG NOTES DURMG | PRETRAL

CAD! 108 EVEENCE | PRETRIAL
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Figure 5-4. Jury Instructions > Chapters/Sort page

History page

The Jury Instructions tab's History pageis used to managethe Requested-By Flags and Status flags
of Selected Instructions. To seta flag, you can simply right-click an instruction on the listand choose
the desired flag on the shortcut menu.

Master nstruchions vao BBz & M wt# |

Personal Instiuctions Recuestee Tyoe nstructen | Descrictor Header Status

Iy NOT SPETULATE 23 TD RENOVAL OF
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asu 1850 FORN OF SFECIAL VERDICT-TENTIONAL Nose
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v
v CAD 100 PRELMNARY ADHONITORS Nors

Hietory J o m | OVERVEW OF TRIAL “Note
vt e | TAKING NOTES DURING THE TRIAL Hore
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o cac 190 DUTY TO ADDE By TRAMSLATON PROVOED W Fropossd

Figure 5-5. Jury Instructions > History page

Search for and within instructions

Jury Instruction Selector offers several methods for searching for and within instructions: jumping to
the first instruction of a certain type (on the Master Instructions tab only), searching by instruction
number, and searching for text within instructions.
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Search by instruction number

Use the Jury Instructions tab's Inst. # box when you know the number of the instruction you seek.
Starting at the beginning of its database of instructions, the program jumps to the first instruction
whose number matches your entry.

NOTE: In the program's database, the first set of instructions is the BAJlinstructions. When the
program searches for an instruction by number, it begins with the BAJlinstructions, regardless of
which set of instructions you may have elected to always be listed first on-screen.

Janpae Bs

‘ Goto lBAn Instructions _:_]

| USE OF INTERAGGATURES UF A PARTY

L REQUFSTS EOR ADMISSINNS.

240

Cart

Figure 5-6. Inst. # box and a matching instruction

Jump to the first Master Instruction of a certain type

As you work on the Jury Instructions tab's Master Instructions pageto select jury instructions, you
might find it convenient to quickly go to Master Instructions of a certain type (e.g., BAJlor CACI).

You can do so easily with the Go to drop-down list. Just select from thelist the type of jury
instructions you areinterested in. The program will jump to the first instruction of that type.

NOTE: If you want Jury Instruction Selector to always list instructions of a certain type first, set the
Choose which set of instructions to display first option as you prefer on the Options window's Display

tab. See "Setdisplay options," page 22.

VEDRD Bz & &

{ [caCimmstuctons -
—{CACT Instructiore
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ALl 4] PRELMINARY ADNONTIONS

| OVERVEW OF TRIAL

4

J CACI 102 ‘ TAXNG NOTES DURNG THE TRIAL 1272007

CAC 107 LIMILTIRLE PARTIES A0S

Figure 5-7. Go to drop-down list

Search for text

Use the Search feature to search for text in Master Instructions or theirCommentaries. This is a quick
way to find Master Instructions that are pertinent to the case whose jury instructions you are
preparing.

The Search featurefinds only exact matches of yoursearch text. Endings (eg., "ing,""ly," "es") are not
considered. You might find it useful to conduct multiple searches seeking various endings.

To search for text in Master Instructions and their Commentaries

1. Click M Search on the Jury Instructions tab's toolbar, or choose Tools > Search
The Search window opens.
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2. IntheSearch for terms box, type the word or phrase you want to find. To find an exact phrase,
such as "dog bite" frameit with quotation marks.

Select the applicable Search in option: Instructions, Commentaries, or Both.

4. Click Search.
The program searches in and lists those Master Instructions and/or Commentaries that
contain the exact matches of your search terms. Notice that the searchresults are ranked by
theirrelevance. The100% relevanceindicates that the search term matched exactly; lower
percentages indicate that the exact search terms were not found. The higher the relevancy
percentage, the morelikely you areto find the information you seek in an instruction.

NOTE: If you search for common text that results in many matches, such as theword ""the," a
message appears indicating that only the top 100 matches will be shown. If more than 100
matches exist, an information message appears to inform you that there are"'too many
solutions."

5. Youcannowdo any of the following with a match you select on the list:

o Click Select Instructionto include this instruction in the instruction set. In response to
the confimation message, click OK.

NOTE: If the Select Instruction button is notenabled, the instruction is already
includedinthe instruction set.

o Click View Instruction to view the instruction's text. (You can't edit the instruction here
because you are actually viewing the Master Instruction.)

o Click View Commentary to view theinstruction's Commentary.

6. Whenfinished with searching, click Close on the Search window.
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View the text of a Master Instruction

At any time, you can view the text of a Master Instruction (Figure 5-8) to review its relevanceto the
case. You especially might want to do so before deciding to selectit forinclusion inyourinstruction
file. (For the same reasons, also view its Commentary; see "View a Commentary," next page.)
To open a Master Instruction

e Onany page of the Jury Instructions tab where the instruction you areinterestedin is listed:

o Right-click its row and choose View Instruction on the shortcut menu.

o Highlight the row and click View Instruction on the tab toolbar.

o Highlight the row and choose Instruction > View Instruction.

e Onanywindow (such as the Edit window) where the | View Instruction buttonis
available, clickit.

The Master Instruction opens in the View Instruction window.

DVERVIEW OF TRIAL

! To assst you in vour tasks as jucors, Iwill now explain how the tnal will procesd. [Name of plaintiff] -«
|fxled this lawsuct. [He/She/lt] 15 called a plainndt. [He/She/lt] secks damages [or other relief] from [name of
defendant], who is called a defendant. Each plaintiff and cach defendant is called 2 party to the case.

First. each side may make an opening statcement, but neither side is required o do so. An opening
Fatemant i3 not evideacs. Ir is Imply an outline to help you understand what that party axpacts the svidencs will
snow. Alse, bacause i 13 often difficult to give you the evidence in the crder we swould prafer, the opening
saternent allows you (0 Keep an overview of the cas wn mind duning the presentation of the evidance.

Next, the jury will hear the evidence. [Name of plaintiff] will present [hisher/its] evidence first When
[name of plaintiff] 15 finiched, [name of defendant] will have an opportunity to present [hisher/its] svidence

Each witness wall first be questoned by the 9de that aked the witness to testify. Thus is called direct
jexamination. Thea the other side s permutted to question the witess. This is called cross-cxamination. N

Documents or objects referred to duning the trial are calied exhibizs. Exhibits ace given a [numberletter]
and marked so thev may be clearly identified. Exhibits are not evidence unsdl I admit them into evidence. During
wour daliberations, you will be able to look ar all exhibits admittad into svidence.

1 There age many rules that govern whether somathing will be considerad evidencs in the tnal. As one sde
presents evidence, the other 30e has the right 1o object and (o ask me (o deaide if the evidemce 15 permitied by
{the rles. Useally, 1wl dacida immediately, but sometimes 1 may have 10 hear argements ows de of your
[presence
| After the evideace has been presented, I will instruct you on the law that applies to the case and the
!zmmeys will make closing arguments. What the parties say tn doang argument is not evidence. The arguments
|are offesed to help vou uaderstand the evidence and how the law applies to it.

[In this case. [name of plaintiff] cizims [insert description of the clements of plaintff's daim(s)].
[[Name of defendant] claims [insest description of the elements of defendant's affirmative defense(s) andor -

2

@ Copyrght 2004 Judicial Cagnct 0f Calfomia. Al ngnts reasryen
’ -

Figure 5-8. A Master Instruction opened in the View Instruction window

By default, a Master Instruction appears with its auto-populatefields (those bracketed text and
blanks that can bereplaced with case information) shown in bold. (To toggle the bolding on and off,

click B | Bold Case Info on the window's toolbar.) You can seewhich case information field is tied
to a particular auto-populate field by right-clicking the field to open a preview balloon (Figure 5-9).
Click OK to closethe balloon.
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To a9 vou tn vour 1asks asjurors, [ will Ww. [Name of plaintiff]
hled thie lawant. [He'She'lt] 1= called a plamnhff seeks damages [or other relief] from [name of H

efendant], who is czlled a defendant. Each plaint ff and each defeadant s called a party to the case.
First, cach sde may make an opeaing statement, but peither 96¢ is required to do s0. An opening

Figure 5-9. Auto-populate preview balloon showing which case information field is tied to an auto-
populate field

From the View Instruction window, you can also print the text of the MasterInstruction and select

and copy someor all of thetextin order to paste it somewhere else. However, you cannot edit the text
of a Master Instruction.

View a Commentary

A Master Instruction's Commentary (Figure 5-10) offers general discussion and guidance explaining
how to use that particular instruction, as well as (for most instructions), sources and authority. All
Master Instructions have Commentaries. Reading through an instruction's Commentary can help you
decide whether to select the instruction forinclusion in yourinstruction file. A Commentary can even
help youdecide how to edititforthecaseyouare workingon.

Many Commentaries include editorial reference links to related jury instructions.

NOTE: While editing a Selected Instruction, you can append Commentary text to the instruction. (See
"Add authorities to Selected Instructions," page 71.)

Toviewa Commentary

e Onany page of the Jury Instructions tab where the instructionyou areinterestedin is listed:

o Right-clickits row and choose View Commentary on the shortcut menu.

o Highlightthe rowandclick'3 View Commentary on the tab toolbar.

o Highlight the row and choose Instruction > View Commentary.

e Onanywindow (such as the Edit window) where the [d l View Commentary buttonis
available, clickit.

The Commentary opens in the View Commentary window.
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DIRECTIONS FOR USE

This instruction s tntended to provide a "road map” for the jurors. Thus instruction should be read tn
conjuacton with CACI No. 100, Prelinunary Admon:tioas,

Throughout these instructions, the names of the partics should be inserted as indicated. This instruction
should be modified to reflect the mumber of plaintiffs and defendants involved in the suit.

If the case involves cross-complainants and cross-defendants, make sure that the names of the parties
inseeted in the applicabla instuctions are adjusted acoordingly

The bracketad last paragraph 13 optional. At its discretiost, the coust may wish to vse (ks paragraph to
provide jurors with 2 brief desmiption of the ciaims and dafenses that are at :s3ue 1n the case

SOURCES AND AUTHORITY

> Rule 2 1035 of the Cahformia Rules of Court provides "Immediately after the jury 1s sworn, the tnal
judge may. ta lus or her diszetion, preinstruct the jury concermng the elements of the charges or daims, its
es, tts conduct, the order of proceedings, the procedure for submiting writien questions for witnesses as set
forth 1o sule 2.1033 if questions are allowed, and the legal principles that will govern the proceediag.*
Lw > Code of Civil Procedurs section §07 provides:
ial

When the jucy has been swom. the trial must proceed in the following order, unless the court, for
reasons otherwise divects:
1. The plzintiff mav aze the i3:e and his cass;
2. The defendant may then state his dafenss, if he 2o wishes, ot wait untif after plaint¥

|
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@ Copyright 2009 Jugicinl Coancl of Talfornia ATngnts reserved

Figure 5-10. A Master Instruction's Commentary in the View Commentary window

Select and edit instructions for your instruction file
This section explains how to selectinstructions foryour instruction file and edit them as needed.

NOTE: Periodically save your instruction file as you work.

Select an instruction

You can easily select a MasterInstruction or Personallnstruction forinclusion in yourinstruction file,
thereby making it a Selected Instruction. Onceyou've selected it, you are then free to edit it as needed
forthecase
To select an instruction for inclusion in your instruction file

1. Working on the Jury Instructions tab's Master Instructions page or Personal Instructions

page, find the instruction youwantto select foryourinstruction file.

2. Toselecttheinstruction, clickanywhereon its row orclick J Select/Deselect Instruction
on the tab toolbar.
A check mark appears in the Requested column of theinstruction's row.

Select related instructions

While viewing a Master Instruction's text or its Commentary, you can easily select instructions that
arerelated toittoadd toyourinstructionfile.

To select instructions related to the openinstruction

1. View the Master Instruction (see page 59) or view its Commentary (see previous page).

2. OntheView Instruction or View Commentary window, click @ | Related Instructions.
The Related Instructions window opens, listing all theinstructions related to the Master
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3. From the Direct or Related Instructions list, select oneor more instructions. (To select multiple
instructions, use Shift+click or Ctrl+click.) Then click Add Selected>. If you want to add all
of theinstructions, click Add All>>.

NOTE: You canview the text of instructions, oneat a time, by selecting an instruction and
clicking View Instruction.

4. When ready to add the selected instructions to your instruction file, click Select Instructions.

Import Selected Instructions from another instruction file

There may be times when you would like to import Selected Instructions from another instruction file
of the same case type (e.g., civil or criminal). You can import instructions from files created with
Version 4.0 and later of Jury Instruction Selector.

To import instructions

1. Opentheinstruction file (see page 38) into which you want to import Selected Instructions
from another instruction file.

2. Click @ | Import Instructions on the main toolbar, or choose File > Import Instructions.
The Open Instructions window opens.

3. Navigate to and select the file from which you want toimport and click Open.
The Import Instructions window opens.
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4. Selectwhereto place theimported instructions inrelation to the currently selected instructions
and click OK.

o Combine places theimported instructions within the existing instructions in numerical
order.

e Insert at beginning adds the imported instructions to the beginning of the instructions.
e Append atendadds the imported instructions to the end of the instructions.
5. Inresponse to the confiimation message, click OK.

6. Ifanimported instruction duplicates an existing instruction in the destination instruction set, a
confimation message appears, prompting if you want to retain the existing instruction.

o To retain the existing instruction (thereby skipping the imported instruction), click Yes.
o To replace the existing instruction with the imported instruction, click No.

The instructions are imported, which you can view on the Jury Instructions tab's Selected
Instructions page.
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Open a Selected Instruction for editing

In order to edit a Selected Instruction, such as to auto-populate it with case information, check its
spelling, or convert it to a vedict, you mustopen itin the Edit window. That window is accessible

only from the Jury Instruction tab's Selected Instructions page.
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To asz=st vou 1 vour taks 23 jurors, 1 wall now explain how the tnal will procead. (Name of plaingiff) 4
lad this lawsoit. [He/She/Te) 13 called a plainn fY. [HeShelt) soeks damages [or other relied] from [name of
efendant], who 1s calied a defendant. Each plainti it and each dafendant 13 called a party (o the case.

First, each side may makes an opemng satement, but neither ade 1s required to do s0. An opeming
emient is not evidence. It ts smply an outline to help you understand what that party expeds the evidence
show. Also, because 1t 1s often difficult to give vou the evidence in the order we would prefer, the opening
allows you to keep an overview of the case in mind during the presentation of the evideace.
Nexe, the jury will hear the evidence. [Name of plaintiff] will presear [hisher/its] evideace firss. When
[name of plaintiff] iz finished. (name of defend ant] will have 20 opportunicy to present [hisher/its] [~
evidence 1
Each wimess will first be questoned by the 2de thar asked the witnass to taxtify Thisis called dirace
ination. Then the other side 13 permitted to question the witnass. This is called cross-examination.
Documents or objects referred to dunng the trial are callad exhitnts. Exiubits ars ;xven a [nmnbe(ﬂanu]
marked so they may be dearly idenhfied. Exhitnts are not evidence unhi 1admit them info esidence.
(During vour deliberations, you will be able to ook af all exhibits admitted inte evidence.

There are many rules that govern whether something will be considered evidence in the trial. Asone
de presents evidence, the other ade has the right to object and to ask me to deade if the evidence is permutted
v the rules. Usually, Iwill deads immediately, but sometimes [ may have to bear arguments cutsde of your

esence.
After the evidencs has been presented, Iwill instruct you on the 13w that applies to the case and the
vs will make cosing arguments. What the parties sav ia closing argument is not evideace. The arguments
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Figure 5-11. Edit window, showing a Selected Instruction ready for editing

Toopen a Selected Instruction for editing
1. On the Jury Instructions tab's Selected Instructions page, find the instruction you want to
open for editing.

2. Do either of the following:
e Double-click anywhere on the instruction's row.
 Highlight(click once on) the instruction's row and click @ Edit Instruction on the
page toolbar or choose Instruction> Edit.

The Edit window opens showing the instruction's text.

Onceyou have opened a Selected Instruction, you can easily editit as you would using a text editor or
basic word processor. Forexample, youcan placethe insertion marker where youwanttoinsert new

text and then type the text.

| New text has been inserted here. |Co assst
walt prooe«f [Name of plaintiff] £{=6 tds lavs
[or other reliaf] from [name of defendant], wh

called a parey to the case.
First zach side may maks an opening stal

Figure 5-12. Selected Instruction in which text has been inserted
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Also use the features on the window's menu bar and toolbar to further edit the instruction, using the
techniques later in this section.

Save an edited Selected Instruction
When you areready to save an edited Selected Instruction, use the Edit window's ﬂ | Save button.
To save an edited Selected Instruction

1. Click = | Save on the Edit window's toolbar.
If this is the first time you have saved the instruction, a confirmation message appears to ask if
you want to set the instruction's Status flag to "Given as Modified."

Would you like the instruction to be "Given as Modified"
n the history table?

2. Respond appropriately.

Auto-populate Selected Instructions with case information

Many instructions include auto-populate fields that areintended to be replaced with stored case
information. You can recognize these auto-populate fields by the brackets that frame them. The
brackets may appear as parentheses (), square brackets [ ], or angle brackets < >, depending on the
type of instruction (e.g., civil, criminal). You can also quickly distinguish the auto-populate fields by

clicking B | Bold Case Informationon the Edit window's toolbar.

Using the Auto-populate feature, you can replace these bracketed fields with applicable stored case
information. For example, wherever the field "[name of defendant(s)]" appears, it will be replaced with
the defendant's name. Similarly, gender phrases such as "[he/she]" will be replaced with the correct
pronoun for the defendant's or plaintiff's gender.

You can auto-populate Selected Instructions individually or globally.

NOTES:

(1) If you attempt to manually edit the text within an auto-populate field, you will be alerted that the
field will be changed to text and can no longer be auto-populated. You can elect to proceed or to
cancel your edit.

(2) If you re-auto-populate instructions atsome point in future, they will be updated with the latest
stored case information. (Gender phrases are the exception.)

TIP: As a best practice after auto-populating an Selected Instruction, be sure to review brackets and
blanks. (See "Review brackets and blanks in Selected Instructions," page 67.)
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Figure 5-13. An auto-populate field on a Selected Instruction

NOTE: To quickly see exactly which case information field is tied to a particular auto-populate field,
right-click the auto-populate field. Thatwill open a preview balloon that identifies the case
information field. (See Figure 5-9.)

Auto-populate individual Selected Instructions
Use the following procedure to auto-populate an individual Selected Instruction.

To auto-populate an individual Selected Instruction

1. Openthe Sdected Instruction for editing (see page 64).

2. OntheEdit window's toolbar, click A“l' | Auto-Populate.
Theinstruction's auto-populatefields arereplaced by applicable case information and are

highlighted for easy identification. (If you don't see the highlighting, click % | Highlight Text
Changes.)

3. Lookthrough the highlighted changes, and edit any that need further editing.

4. Click g I Save to save.

Respond as needed to the confirmation messageregarding the "Given as Modified" status
flag.

Globally auto-populate all Selected Instructions
Use the following procedure to auto-populate all Selected Instruction.

To auto-populate all Selected Instructioninstructions
1. Do either of the following:
o Withanytab open, choose Tools > Automated Tools > Auto-Populate All

Instructions.

o Onthelury Instructiontab's Selected Instructions page, click A‘P Auto-Populate
Al Instructions.

2. Respond as needed to the confimation messageregarding the "Given as Modified" status
flag.

3. Ontheinformation window that opens, click OK.
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Review brackets and blanks in Selected Instructions

Many Selected Instructions contain brackets and blanks that identify places where you may want to
replace text, selectfrom among optional text, or enter text (Figure 5-14). Brackets (parentheses (),
square brackets [], orangle brackets <>, depending on the type of instruction) indicate places where
you canreplace text or select from among optional text forgrammatical comrectness. Blanks indicate
places where you can insert text. Someblanks include explanatory text in parentheses to suggest
whatyou areto insert. For example, you might see something like"__(insertduty)__."

NOTE: Many bracketed fields are auto-populatefields, which you can replace with the Auto-
Populate feature (page 65). But, as a best practice, you should auto-populate your Selected
Instructions first, and then review brackets and blanks and make any necessary manual edits.

You can review brackets and blanks in Selected Instructions individually or globally.

(%% (%W (=% 2] )

N el
JURY NOT SFECULATE AS TO REMOVAL OF CLAIMS OR PARIILS

| Thessue of the hability of the! dcfendam(s] Margorie Smith as to the [daim(s] for 3 .|
| [:5] [are] ho longer before You. =
| = Do e condoer thiz for anv purpose. It is pot relevant to whether md dcfendam[s] [is] [arc] p:blc or pot
lizble as to any remaining claim[s].
Further, do not comcinds from the face that this instruction has besa m!h:flam expressing anv opinion
to the facts or whether [any] : Hefendant is liable or not liable of any dmm[s]

Figure 5-14. Brackets and blanks in a Selected Instruction (after auto-populating)

Review brackets and blanks in an individual Selected Instruction
Use the following procedure to review the brackets and blanks in an individual Selected Instruction.

To review brackets and blanks in an individual Selected Instruction

1. Openthe Selected Instruction for editing (see page 64).

o[z

2. OntheEdit window's toolbar, clickﬂ Brackets and Blanks Review.
Thewindow changes to the Brackets & Blanks Review window. (Notice the window's title.)
Thefirst bracketed text or blankis selected, ready for you to review and edit as needed.

3. Editthe brackets and blanks manually.

Position the insertion pointer anywhere within the instruction to manually edit text at that
point. (If you manually edit within the brackets of an auto-populate field, an information
message will appear to alert you that the Auto-Populate feature will be disabled for that field.
Respond appropriately.)

Also use the following editing shortcuts.

e Ctrl +n, wheren is a number corresponding to an option's position within a set of
bracketed options — Selects an option by its position. For example, given the options
[attendant/bailiff], you could quickly select "bailiff" by pressing Ctrl+2.

o 'x’ Cut or Ctrl+X - Deletes the selected placeholdertext or blanks. You can then type
new text.

. Copy or Ctrl+C - Copies the selected placeholdertext or blanks for pasting

elsewhere.
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o E Paste or Ctrl+V - Pastes text copied from elsewherein place of the selected

placeholder text or blanks.

« 7| Undo or Ctrl+Z - Reverses the lastchange.

: Redo or Ctrl+Y - Reinstates thereversed change.

IMPORTANT! The authors of the official instructions sometimes inadvertently omit the
bracket that '"closes" some bracketed language. Likewise, you might occasionally
inadvertently remove a closing bracket while editing a Selected Instruction. When the
Brackets and Blanks Review tool advances to one of these "open" or "unbalanced" brackets,
a messageappears saying that there isa bracketin the instruction whose closing bracketis
missing. Forinformation on how to handle these "open'" brackets, visit the Frequently Asked
Question"Whatdo | do aboutan 'open' or'unbalanced' bracket?" in the program's Help
system.

4. To advancethrough remaining items, click b I Review Next or press Tab or Ctrl+Tab.

5. Click g I Save to save.

Respond as needed to the confirmation messageregarding the "Given as Modified" status
flag.

Globally review brackets and blanks in all Selected Instructions
Use the following procedure to review the brackets and blanks in all Selected Instructions.

To review brackets and blanks in all Selected Instructions
1. Do either of the following:

o Withany tab open, choose Tools > Global Review Tools > Brackets & Blanks
Review.

e Onthelury Instructiontab's Selected Instructions page, click 2[; Global Brackets
and Blanks.

2. A confimation window appears prompting you to confirm whetheryou would like the Status
flags forall theinstructions to be set to "Given as Modified." Respond appropriately.
The Global Brackets and Blanks Review window opens, with the first bracketed text or blank
selected, ready foryou to review and edit as needed. (Note the instruction number appearing
between the <Previous and Next> links.)
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3. Usethesametechniques as described above to edit the brackets and blanks.

4. Whenyou havefinished reviewing brackets and blanks, click =l | Save to save.

Check spelling

Use the Spell Checker window to search for and correct misspellings in your Selected Instructions.
You can spell-check Selected Instructions individually or globally.

InDigonay.  |ma
Chargeln  Jnalr

Sugoettions: x;" €8 Change I X I
E?‘l s | 7 swen |
Ei‘? o lgoe | g lmen |
mw X Cance |

Figure 5-15. Spell Checker window
Table 5-1. Spell Checker buttons

Button Description
Change Changes the misspelled word with the text in the Change To box.

Change Changes all occurrences of the misspelled word with the text in the Change To box.
All

Add Adds the text in the Change To box to the dictionary. In response to the "Add 'text' to dictionary"
message, click Yes or No as desired.

Suggest Updates the list of suggested replacements shown in the Suggestions list.

Ignore  Ignores the current misspelled word and searches for the next.

California Jury Instruction Selector User Guide (Version 6.1) 69



Chapter 5. Working with JuryInstructions
Select and edit instructions for your instruction file

Button Description

Ignore Ignores all occurrences of the misspelled word.
All

To spell-check anindividual Selected Instruction
1. Openthe Sdected Instruction for editing (see page 64).
Fz};
2. OntheEdit window's toolbar, click Spell Check.
If a misspelledword is found, the Spell Checker window opens.

3. To correct misspellings, use the buttons described in the table below.

4. Click g | Save to save.

Respond as needed to the confiimation message regarding the "Given as Modified" status
flag.
To spell-check all Selected Instructions
1. Do either of the following to begin:
: : g
o Onthelury Instructions tab's Selected Instructions page, click Global Spell
Check.
o Withany tab open, choose Tools > Global Review Tools > Spell Check.

The Edit window opens, over which, if a misspelled word is found, the Spell Checker window
opens.

2. To comect misspellings, use the buttons described in the table below. As you work, the
program will automatically find the next misspelling.
When all misspellings have been addressed, the Spell Checker window closes.

3. Ontheinformation window that opens, click OK.

Search for and replace text in Selected Instructions

With the Replace feature, you cansearch fortextin oneor more Selected Instructions and replace it
with other text.
To search for and replace text in Selected Instructions

1. Do either of the following to begin:

a
e Onthelury Instructions tab's Selected Instructions page, click bb Replace.
o Withanytab open, choose Tools > Global Review Tools > Replace.

The Replace window opens, showing the first Selected Instruction. (Note the instruction
number appearing between the <Previous and Next> links.)
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2. Inthe Find what box, type the text you want to search for. In the Replace with box, type the text
you want to replace it with.

3. SettheScope and Options settings as desired. Forexample, you can elect to searchin the
displayed instruction only and to match case.

4. When ready to search, click Find Next. If an occumrence of the search textis found, click either:
« Replace to replace only this occurrence.

o Replace All to replace all occurrences (eitherin the open instruction only or in the
entireinstruction set, depending on the scope).

5. To advance to the next selected instruction in the instruction set, click Next>. (You do not need
to do this if thescope s for all instructions.) Repeat the process to search for and replace
more occurrences.

6. Click n | Save to save.

Respond as needed to the confirmation messageregarding the "Given as Modified" status
flag.

Add authorities to Selected Instructions

Forsome or all of your Selected Instructions, you may want to add authorities to them so that the
authorities will appear in the printed jury instructions. The authorities maternal originates from the
Commentaries associated with the instructions. In fact, when you add authorities, you actually
append the entire texts of the Commentaries to the end of their respective instructions. (You may then
wantto remove any materal that you do not wantto include in the printed jury instructions.)

You can add authorities to Selected Instructions individually or globally.

To add authorities to an individual Selected Instruction

1. Openthe Selected Instruction for editing (see page 64).

2. OntheEdit window's toolbar, click (+d Add Authorities.
Thecomplete text from the instruction's Commentary is added to the end of the instruction.
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3. Click g l Save to save.

Respond as needed to the confirmation messageregarding the "Given as Modified" status
flag.
To add authorities to all Selected Instructions

1. Do either of the following to begin:

e Onthelury Instructions tab's Selected Instructions page, click B4 Add
Authorities to all selected instructions.

o Withany tab open, choose Tools > Automated Tools > Add Authorities All
Instructions.

2. Respond as needed to the confimation messageregarding the "Given as Modified" status
flag.

3. Ontheinformation window that opens, click OK.

Convert a Selected Instruction to verdict format

You can easily convert the text of a Selected Instruction into the format of a verdict. For example, for a
criminal case, you caninclude the "Guilty" and "Not Guilty" instructions and convert thesetoverdict
format. (You can always revert back to a normal instruction if needed.)

Convert a Selected Instruction to a verdict

To convert aninstruction to a verdict
1. Openthe Selected Instruction for editing (see page 64).

-
2. OntheEdit window's toolbar, click S I Make Verdict.
A waming message appears prompting if you want to convert the instruction to a verdict.

i Do you vant to convert this

instruction to s vesdict?

s ] M | bee |

3. Click Yes to convert theinstruction.
Theinstruction is now reformatted as a verdict.

4. Click g | Save to save.

Respond as needed to the confirmation messageregarding the "Given as Modified" status
flag.

Revert a verdict back to instruction format
Provided that you have saved the instruction file, any edits you have madeto a verdict will remain

intact when you revertit back to a standard instruction. (If you havenotyetsaved yourinstruction file,
any edits you made to the verdict will be lost when you revertit to an instruction.)
Torevert averdict back to aninstruction

1. Openthe Sedlected Instruction for editing (see page 64).
2. On the Edit window that opens, click
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-
5 | Undo Verdict.

A waming message appears prompting if you want to revert the verdict to a normal
instruction.

[ Warming ==

Instruchion s a verdict,
g-_k Do you want to convert it

to a normal instruction?

3. Click Yes to convert back to a normal instruction.

4. Click n| Save to save.

Respond as needed to the confimation messageregarding the "Given as Modified" status
flag.

Remove (deselect) an instruction
You can easily remove (deselect) a Selected Instruction from your instruction set at any time.

CAUTION! Any edits you may have made to the Selected Instruction arelost when you removeit.

To remove aninstruction from your instruction file
e OntheluryInstructions tab, do any of the following:

o OntheMaster Instructions page, locate the instruction and click once on its row.

o Onany of the other pages, locate and highlight the instruction and then click “/
Select/Deselect Instruction, or choose Instruction > Select/Deselect.

Theinstruction is no longer a Selected Instruction in your instruction file.

Fine-tune the order of Selected Instructions in your instruction file

Onceyou haveselected all theinstructions you want to include in yourinstruction file, you can then
arrangethe orderin which they will appear when printed. You can move theirposition relative to other
instructions. If you will be printing them in Booklet format, you can also edit, as needed, the titles of
the chapters in which the instructions will appear.

Change the print order of Selected Instructions

By default, Selected Instructions are arranged alphanumerically by theirinstruction numbers (which
are, in turn, associated with default chapters for the Bookletformat). Thisis the defaultorder in which
jury instructions will be printed. However, you can change the order as you prefer, which you do on the
Jury Instructions tab's Chapters/Sort page.

NOTE: The new arrangement of instructions will be reflected as well on the Jury Instructions tab's
Selected Instructions page and on the Print tab's Choose Instructions page. When you print
Selected Instructions, they will print in this order (unless you override the order at the point of
selecting which instructions to print).
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To change the print order of Selected Instructions

1. On the Jury Instruction tab's Chapters/Sort page, highlight a Selected Instruction that you
wantto move.

2. Click — Move Up and s Move Down to reposition it on the list. Altematively, drag an
instruction to the desired position. If theinstruction's new position is in a different chapterthan
itsdefault chapter, the Select Chapter Title window opens. Select the chapter titleyouwant
toassociate with the moved instructions and click OK.

Selectthechapter titicto be assoc ated with the maved instruction

Chaptar Tiile
(® GEMERAL INSTRUCTIONS [Current Ghapter)

" PRETRIAL (Succeeding Chapler}

| oK I Cancel I ll

3. Repeat to move other Selected Instructions until all of the instructions arein the orderyou
prefer.
If you plan to printinstructions using Booklet format, continue to "Edit a Selected Instruction's
associated chaptertitle," below.

Edit a Selected Instruction's associated chapter title

NOTE: This section pertains only if you plan to printyour Selected Instructions using the Booklet
format. In that format, instructions are arranged into chapters. If you do not plan to printusing that
format, you can skip this section.

By default, Selected Instructions based on Master Instructions are included in specific chapters based
on their instruction number. For example, instructions whose numbers are in the 100 series are
generally contained in a chapter called GENERAL INSTRUCTIONS.

But if you changed the order of the Selected Instructions (as described in previous page), you will
likely need to edit the associated chaptertitles of at least some of those instructions. Why? Consider
the situationin which you have a number of instructions all associated with onechapter, but you then
move an instruction associated with a different chapterto a position among them.

For example, the figure below shows an instruction associated with the GENERAL INSTRUCTIONS
chaptermoved to a position among instructions associated with the PRETRIAL chapter. Wereyou to
print theseinstructions using the Booklet format, there would be notone PRETRIAL chapter, but two
PRETRIAL chapters, witha GENERAL INSTRUCTIONS chapter between them. To remedy this
situation, you would edit the title of the intervening instruction to PRETRIAL so that there will be one,
continuous PRETRIAL chapter.
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Figure 5-16. An instruction associated with one chapter moved to appear among instructions
associated with a different chapter

Selected Instructions based on Personal Instructions will not be associated with any particular
chapter. But if you included any in your instruction file, you will also need to edit their "blank" chapter
title to be an actual chapter title. Otherwise, they will appear as "orphan" instructions interspered
among the chapters.

CAUTION! Before editing any chapter title, you should finalize the order of instructions in case you

laterdecide to use the ¢ Reset Chapters button to return theinstructions to their chapter
defaults. Resetting chapters affects both the order of theinstructions and their associated chapter

titles.

To edit a Selected Instruction's chapter title

1. On the JuryInstructiontab's Chapters/Sort page highlight an instruction whose chapter
titleyou want to edit.

2. Click 4 | Edit Chapters on the page's toolbar.
The Edit Chapter Title for Selected Instruction window opens.

Selthe chapter titefor the seected instruction
Instrechon Tite
BITEA
BITING FOLICE DOG CAJSING INJURT
Chapter Title: l ﬂ
OK I Cancel | Restors I 2 l

3. From the Chapter Title drop-down list, which lists only those chapters associated with the
Selected Instructions, select the appropriate chapter. Altematively, type the name of a custom
chapter. (The program does not require that the titlebein all caps, but you might preferto do
so for consistency with other chaptertitles.)

4. Click OK to save andclose.

5. Repeatas needed to editotherinstructions' titles.
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Reset Selected Instructions' order and associated chapter titles

With the Reset Chapters feature, you can easily resetboth the order and associated chapter titles of
your Selected Instructions. You do this on the Jury Instructions tab's Chapters/Sort page.

CAUTION! Resetting chapters affects both the order of instructions and their associated chapter
titles.

Toreset Selected Instructions’ order and their associated chapter titles

1. OnthelJury Instructiontab's Chapters/Sort page, click ¢ Reset Chapter.

2. Inresponse to the confimation message, click Yes.

@ Would you like to restore chapter tithes and resequence to their defzult?

Track the history of Selected Instructions

This section begins by defining the History Table and then covers how to track the history and status
of your Selected Instructions (e.g., who requested an instruction's inclusion, was it modified, was it
refused, and so forth).

About the History Table

The History Table is a database table that stores flags used to track the history and status of Selected
Instructions in an instruction set. There are two types of flags:

e Requested-By flags — As their name suggests, these flags indicate who has requested the
inclusion of an instruction: the plaintiff, the defendant, the court, orsome other party. (See
"Assign Requested-By flags," below.)

o Statusflags — These flags indicate whether an instruction will be givento the jury "as
modified" or "as requested" or whetherit has been refused or withdrawn. (See "Assign Status
flags," facing page.)

Theflags associated with the Selected Instructions will be appear in the printed jury instructions (if
you so elect).

Assign Requested-By flags

As needed, you can assign a Requested-By flag to aninstruction to indicate who requested the
instruction. For example, when the defendant's attorney requests a particular instruction, assign it the
"Requested by Defendant" flag.

Thefour Requested-By flags (for Plaintiff/People , Defendant, Court, and Other) appear in the
Requested column of instructions (with one exception, described below). You can assign the flags on
any of the pages of the Jury Instructions tab (although we suggest not doing so on the
Chapters/Sort page becauseit doesn't show the Requested column). You may assign more than one
Requested-By flag to the same instruction.
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To assign a Requested-By flag to aninstruction
1. Onany pageof the Jury Instructions tab (otherthan Chapters/Sort), do any of the following:

¢ Right-click the instruction and choose the desired Requested-By flag on the shortcut
menu.

o Highlight the instruction, and then use the applicable menu command, button, or
keyboard shortcutto selectthe desired flag. Repeat to add otherflags to the same
instruction, if needed.

Flag Menu command Butto Key
n
Plaintiff/ Instruction > Requested By > m P or Shift+Ctrl+P
People Plaintiff/People
Defend ant Instruction > Requested By > Defend ant m D or
Shift+Ctrl+D
Court Instruction > Requested By > Court C or Shift+Ctrl+C
Other Instruction > Requested By > Other n Oor
Shift+Ctrl+O

In the case of Plaintiff/People, Defendant, or Court, the corresponding flag now appears in the

Requested column.
Requeeted | Type | msiructon | Frivt oaie
v o | 272008
/ | 42007

| 472004

In the case of Other, the Other Party Name window opens.

Entsr the name 316 party below.

Other Party Name: { _vJ

oK || Cancel I _?l

2. In the Other Party Name box, select or type the name of the party otherthan the plaintiff,
defendant, or courtwho has requested the instruction, and then click OK.
The Other flag appears in the Requested column.

Toremove a Requested-By flag

o TheRequested-By flags' commands, toolbar buttons, and keyboard shortcuts work as
"on/off" toggles. Use the same techniques as above to remove (deselect) flags.

Assign Status flags

Use Status flags to track the status of aninstruction. You can indicate if a giveninstruction is Given
As Requested, Given As Modified, Refused, Withdrawn, or Proposed.

By default, an instruction's Status flag is setto None whenitis first selected forinclusion in the
instruction file. Whenever you edit a Selected Instruction, Jury Instruction Selector will conveniently
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promptif youwantto setits Status flag to Given As Modified. Typically, aftera conference between
the court and the attorneys, you will change the Status flags of some of the Selected Instructions.

You can set an instruction's Status flag while viewing the Jury Instructions tab's Selected
Instructions, Chapters/Sort, or History page. However, only the History page has a Status column
where you canview how the Status flags are set.

To assign the Status flag of aninstruction

o Onthelury Instructions tab's Selected Instructions, Chapters/Sort, or History page,do
either of the following:

o Right-clickthe instruction and choose the desired Status flag on the shortcut menu.

o Highlightthe instruction, and then use the applicable menu command or keyboard
shortcut to assign the desired flag.

Flag Menu command Key

Given As Instruction > Status > Given As Shift+Ctrl+R

Requested Requested

Given As Modified Instruction > Status > Given As Modified Shift+Ctrl+
M

Refused Instruction > Status > Ref used Shift+ CGtrl+F

Withdrawn Instruction > Status > Withd rawn Shift+Ctr+
W

Proposed Instruction > Status > Proposed Shift+Cti+S

Onthe History page the corresponding Status flag now appears in the Status column.

Requested IType |h:1mctim Ioem ) | states l
J  caa 108 EvioEne  Gfe ags \ernaelloaﬂeo
o  caa 1107 | VATNESSES N ]"éwenae'udaiﬁea

Toremove a Status flag

o Onthelury Instructions tab's Selected Instructions, Chapters/Sort, or History page,do
either of the following:

o Right-clickthe instruction and choose None on the shortcut menu.

o Highlightthe instruction and choose Instruction> Status > None or press
Shift+Ctrl+N.
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This chapterdescribes the various formats in which you can provide printed jury instructions. It also offers procedures for
setting various printing preferences and for printing, previewing, and printing instructions to a file.
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Set the default print-10-file file tYPE wuesaimiminim e memismsm i, yiwe i mersss by s s nbsin sy e my e wins 94
Choose INStrUCtioNs fOr PriNtiNg I e SN RSSO RS e 95
Set format options for the Print Job - - .- 96
Print jury iINStrUCTIONS - - . ..o oo e e e e et e e e e e e e e e meaeeean e 96
Preview before printing - - . oo e ieaaeieeeeceeaaaaas 96
Print instructions to a file e s d R s S S S e e e e D L R S R S s A SO B S Sas s 97
Print anindividual inStruction - .. .o e ieieieeeea. 98
Print an instruction's ComMmMENtary .. ... e e e e 98
Print a list of INStrUCHIONS i st s e o e o L M R L L S S e S 2 i B e i L 98

About printing

Jury Instruction Selector offers several formats for printed jury instructions The court may prefera
particular format, so be sureto inquire before preparing the printed instructions. Take a few moments
to familiarize yourself with the formats. For detailed information, begin with "Print formats," page 85.

You will select instructions for printing and set various print format options on the pages of the Print
tab. For detailed information, begin with "Print tab," next page.

Besides using oneof the print formats, you can also print the text of an individual instruction (page
98), print the text of a Commentary (page 98), and print a list of instructions (page 98).

Before printing for the first time, we suggestyou set some defaults:
e Setup thedefault printer (page 93)
o Set the default print-to-file file type (page 94)
o Setthe default fonts for printing (page 93)
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Print tab

When ready to printyour jury instructions, you will work on the Print tab (Figure 6-1). Along its left
panel, the tab is divided into pages, such as Choose Instructions, Single Page, and L.A. County
Forms. Justclicka heading to go to the page you wantto work with.

Choose Instructions page

Use the Choose Instructions page of the Print tab to select which of the Selected Instructions in your
instruction file you would like to print, preview, or print to a file.

.....

Avadatle [retruchons Irchded [reruchon

Lh se Intrpction 1.24

1650
Bingle Page ) A oacnee

3}
LA Courty Forms 1£282-A .__W
1108

Bookiet {107
j108

Plaading

1 [ |31 [+

Rafused VWahdiSmn latnclons

™ Print text of refused/mthdane retruchiom W ok e O ey I

Figure 6-1. Choose Instructions page of the Print tab

Single Page page

Use the Print tab's Single Page page to select options for printing jury instructions using the Single
Pageformat(page 85).

.....

Stavt | Case Infomaton | Yy nsinctors [Prnt

i

SRR A S

Winggle Page Page Settings

Choose Instructans

Other Options

LA Courty Formns
Bockiet

Plaading

* Us= 254ne peper {dodble<paced)
(7 U M0dne pacer apace ard o half)
[V Shaw ine rurben

[V Pk Hstory Tabie
(% Top of Page
 tottom of Page
[V Drsoczrton Tabie (Hstory Indexd

[V Nuvber papen
[V Page foor
[T Us= custon footer

¥ Show reyucton pont dates

W Show wetructon types 0.e, BAIL CACT

M Show nsty utton rustens

W Show reTucton ties

T Remove racket charscies = 5[]

W Use originaly defned persona ©eiucion b

Figure 6-2. Single Page page

"o
TIP: To reset the printing options to their default settings, just click A Restore Defaults inthetab
toolbar.
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Table 6-1. Settings for the Single Page format

Sedtion Desaiption

Page Select
Settings o

Other Select
Options o

from among the page settings:
Use 28-line paper (double-spaced) — Select if the court clerk prefers 28-line paper.
Use 30-line paper (space and a half) - Select if the court clerk prefers 30-line paper.
Show line numbers — Select to show line numbers.

Print History Table — Select to include each instruction's History Table and select the table’s position on the
page (top or bottom).

Disposition Table (History Index) - Select to indude the Disposition Table (page 91), which will be printed on
its own page at the end of the printout.

Number pages — Select to indude page numbers, shown in the bottom center of the page.

Page footer — Select to include a page footer. The default civil case footer reads "Judicial Council of
California Jury Instructions." The default criminal case footer reads "Jury Instructions." You can override the
default footer with your own custom footer; see Custom page footer next.

Custom page footer — Select to use a custom page footer, and type the footer text in the text box.

from among the other printing options:
Show instruction print dates — Select to include the print date of each instruction.
Show instruction types (i.e. BAJ, CACI) — Select to include the type of each instruction, such as BAJl or CAQ.
Show instruction numbers — Select to include the number of each instruction.
Show instruction titles — Select to include the title of each instruction.
Remove bracket characters < > [ ] — Select to automatically remowve all of the brackets that were missed. In
the case of square brackets, the program will accept all of the text found within each of the bracketed text

material remaining after your edits. In the case of angle brackets (used only in CALCRIM), the text between
the brackets is be removed outright. When you select this option, you will be prompted to confirm.

Use originally defined personal instruction numbers — Select to use the instruction numbers (which may
include letters) for Personal Instructions when they were first created. If you clear this check box, the
Personal Instructions will be numbered in order beginning with 1 and in the order shown on the Jury
Instructions tab's Chapters/Sort page.

L.A. County Forms page

Usethe Print tab's L.A. County Formspage to select options for printing jury instructions using the
Los Angeles County Forms 176 /177 format (page 86).

“Stert | Case Infarmatan | Juy Instuctons (PRRE Y

Chooze Instruckany SRR Ak S
Sgle Pags Page Settings Other Options
< [ Dowlespace bnes W Sham rstudion Ytie (header)
Pt 8AX Inmincnone ot W Remove brachet chrocters < » [
Bookix © rorm 110

& Fom 177 N e ariginally defined parscnd inatructon nuvbars

Plearing @ Hatory Tabke (Top of Dace)

W Deposnon Table (History Index)
¥ Page focter

[ Lee austom Tooter

[

Figure 6-3. L.A. County Forms page
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—
TIP: To reset the printing options to their default settings, just click A | Restore Defaults inthetab
toolbar.

Table 6-2. Settings for the L.A. County Forms format

Sedion  Desaiption
Page Select from among the page settings:
Settings o Double-space lines — Select to print text double-spaced.
o Print BAJI Instructions on — Select Form 176 or Form 177.
e History Table (Top of Page) — Select to include each instruction's History Table at the top of the page.

o Disposition Table (History Index) — Select to indude the Disposition Table (page 91), which will be printed on
its own page at the end of the printout.

e Page footer — Select to include a page footer. The default civil case footer reads "Judicial Council of
California Jury Instructions." The default criminal case footer reads "Jury Instructions." You can override the
default footer with your own custom footer; see Custom page footer next.

o Custom page footer — Select to use a custom page footer, and type the footer text in the text box.

Other Select from among the other printing options:
Options o Show instruction title (header) — Select to include the title of each instruction.
e Remove bracket characters < > [ ] — Select to automatically remove all of the brackets that were missed. In
the case of square brackets, the program will accept all of the text found within each of the bracketed text

material remaining after your edits. In the case of angle brackets (used only in CALCRIM), the text between
the brackets is be removed outright. When you select this option, you will be prompted to confirm.

o Use originally defined personal instruction numbers — Select to use the instruction numbers (which may
include letters) for Personal Instructions when they were first created. If you clear this check box, the
Personal Instructions will be numbered in order beginning with 1 and in the order shown on the Jury
Instructions tab's Chapters/Sort page.

Booklet page

Use the Print tab's Booklet page to select options for printing jury instructions using the Booklet
format(page 87).

Start | Case Informeton | Jury Ssmucasns | Pek |

Chonce hetructiong &> 8 A G .

Sing= Page Page Settings Booklet Settings
AL 2 [T Dobiepace nes W Comer Soeet
L Loty Frrms
W Dispodton Tabks (Hstory Tndex) ¥ Table of Contents
oDyt ¥ Mmoo pages ¥ index
Pleadny N Pags footar W Show chaprer headnge

[ Use custon footer
| Other Options

¥ Remove beachet dharachen < > []
W Lo ongnady CRin e Drscedd iatnuctien nunbans

™ Sortpersonal nstructiore numencaly (1L, 2, 3, etc)

Figure 6-4. Booklet page
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"
TIP: If youwant to reset the printing options to theirdefault settings, just click *# | Restore
Defaults in the tab toolbar.

Table 6-3. Settings for the Booklet format

Sedion

Page
Settings

Booklet
Settings

Other
Options

Desaiption

Select from among the page settings:

Double-space lines — Select to print text double-spaced.

Disposition Table (History Index) - Select to indude the Disposition Table (page 91), which will be printed on
its own page at the end of the printout.

Number pages — Select to indude page numbers, shown in the bottom center of the page.

Page footer — Select to include a page footer. The default civil case footer reads "Judicial Council of
California Jury Instructions." The default criminal case footer reads "Jury Instructions." You can override the
default footer with your own custom footer; see Custom page footer next.

Custom page footer — Select to use a custom page footer, and type the footer text in the text box.

Select from among the booklet settings:

Cover sheet — Select to include a cover sheet, which includes the court name, judge name, and date.

Table of Contents — Select to include a Table of Contents, which includes the case name and number, the
instruction Chapter title and appropriate p age locator.

Index — Select to indude an Index, which includes the case name and number, the instruction Chapter title,
each of the instruction titles and numbers, and the appropriate page locator.

Show chapter headings — Select to include chapter titles (e.g., Introductory, Evidence, etc.).

Select from among the other printing options:

Show instruction title (header) — Select to include the title of each instruction.

Remove bracket characters < > [] — Select to automatically remove all of the brackets that were missed. In
the case of square brackets, the program will accept all of the text found within each of the bracketed text
material remaining after your edits. In the case of angle brackets (used only in CALCRIM), the text between
the brackets is be removed outright. When you select this option, you will be prompted to confirm.

Use originally defined personal instruction numbers — Select to use the instruction numbers (which may
include letters) for Personal Instructions when they were first created. If you clear this check box, the
Personal Instructions will be numbered in order beginning with 1 and in the order shown on the Jury
Instructions tab's Chapters/Sort page.

NOTE: If you print instructions using Bookletformat to a word processing fileand elect toinclude a
Table of Contents and/or Index, the pagenumbers will not appear to be present when the fileis first
generated. However, it is easy to reveal the page numbers, using your word processor's specific
features. See the FAQ "Where are the page numbers in the Table of Contents or Indexin my RTF
file?" inthe Help system.
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Pleading page

Use the Print tab's Pleading page to select options for printing jury instructions using the Pleading

format(page91).

SshPR A S
Page Settings
* Us= 254ne peoer (doddle<paced)

(7 Use 30dne paoer {space =rd o half)
[V Show e rurben

Choose Instruchans
Sngle Page

LA Courzy Forms

vilog [V Number pages
[V Page foote
™ Us2 custom footer

Other Options
™ Indude vercct foms
W Use ongraly defined personsl rotuchon numbers

LCourty: l vl

e

FingDete: |12 412008 -

Figure 6-5. Pleading page

g

TIP: If youwant to reset the printing options to their default settings, just click A | Restore

Defaults in the tab toolbar.

Table 6-4. Settings for the Pleading format

Section Desciption

Page Select from among the page settings:

Settings o Use 28-line paper (double-spaced) - Select if the court clerk prefers 28-line paper.
o Use 30-line paper (space and a half) — Select if the court clerk prefers 30-line paper.

o Show line numbers - Select to show line numbers.

o Number pages — Select to indlude page numbers, shown in the bottom center of the page.

o Page footer — Select to include a page footer. The default civil case footer reads "Judicial Council of
California Jury Instructions." The default criminal case footer reads "Jury Instructions." You can override the
default footer with your own custom footer; see Custom page footer next.

o Custom page footer — Select to use a custom page footer, and type the footer text in the text box.

Other Select from among the other printing options:
Options

o Include verdict forms — Select to include a second paragraph, which places the instruction numbers for

verdict forms following the verdict form paragraph.

o Use originally defined personal instruction numbers — Select to use the instruction numbers (which may
include letters) for Personal Instructions when they were first created. If you clear this check box, the
Personal Instructions will be numbered in order beginning with 1 and in the order shown on the Jury

Instructions tab's Chapters/Sort page.

o County - Select a county from the drop-down list. The county you select will be placed in the heading, as in:

SUPERIOR COURT OF CALIFORNIA
COUNTY OF

e Filing Date — Select to include the court filing date in the pleading document. The default date is today's

date.
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Print formats

Thefollowing sections describe and illustrate the various print formats offered by Jury Instruction
Selector.

Single Page format

Use the Single Pageformatto print each instruction beginning on its own page. You can setvarious
printing options as you prefer (page 80), as well as changethe default fonts forthe format (page 93).

CACT 102, TAKING NOTES DURING THE TRIAL

Faquestad oy Vlsinb g Ragquested by Damngaar | T

O O O
Given as Raqoastad D Givar 35 Modied r_'| 1GiTen oa Covet's Motion D
Withésawn M Judgs
Pont date: 122007

You have been given notebooks and may take notes during the rial Do not taks the notebooks
out of the courtrootn of jury room at any time dunng the trial. You may take vour notes mito the jury
room during dekberations.

You should use your notes only to remund vourself of what happened during the tnal. Do not let
vour note-taking interfere wirh your abiity 0 listen carefully to all the rasimony and to watch the
wimesses as they testfly. Nor should you allow your impression of a witness or other evidenice to be
mflusnced by whether or not other jurors are taking notes. Your mdepend=nt recoliection of the
evidence should sovern your verdict, and vou should not allow yoursalf to be influenced by the notes
of other jurors iff those notes differ from what you remember.

The court reporter is making a record of evervilung that is said. If durmg debberations vou have 2
question zbout what the witness said, you should ask that the court reporter’s records be read to
voir You must accept the court reporter's record as accurate

At the end of the wial, your notes will be collected and Jestroved/collected and retamed by the
court but not as a part of the case record’ specify other disposihion.

Pags 1 of 1
Tudicial Council of Califoreia Jury Instructions

Figure 6-6. Single Page format (Rule 201) with the default footer and the History Table at the top
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CACT 102, TAKING NOTES DURING THE TRIAL
Print dae: 122007

You have been given notebocks and mav take notes during the trial. Do not take the notebooks
out of the courtroom or jury room at any tme during the trial You may take your notes info the jury
room during deliberations.

You should use your notes only to rerund yourself of what happened during the trial Do not let
your note-taking mterfere with your ability to isten carefully to all the testimony and to watch the
wimesses as they tastifv. Nor should you allow your impression of a witness or othar evidence 1o be
nfluenced by whether or not other jurors are taking notes. Your independent recoliection of the
ewndance should govern vour verdict. and vou should not allow yourself to be influenced by the notss
of other jurors if those notes differ from what you remember.

The court reporter is making a record of everything that is said. I7 during deliberations you have a
question about what the witness sa:d. you should ask that the court reporter's records be read to
vou You must accept the court reporter's record as accurate.

At the end of the tmal. vour notes will be collacied and destroyved /collectad and retzined by the
court but not as a part of the case record’ specify other dispositon.

REQUESTED BY:

GIVEN AS REQUESTED

GIVEN AS MODIFIED

GIVEN ON COURT'S OWN MOTION
REFUSED

WITHDRAWN

Pag= | of |
SMITHV DCE

Figure 6-7. Single Page format (Rule 201) with a custom footer and the History Table at the bottom

Los Angeles County Forms 176 /177 format

Usethe Los Angeles County Forms 176/177 format to printon Form 176 or Form 177, used for
providing instructions to the jury. Theupper portion is separated and kept with the court files. The
lower portion, which contains theinstruction text, is given to the jury to aid the members in deciding
the case as it clearly pertains to the law.

Form 176 is to be used for personal "specially"-drafted instructions, so itcan include the authorities
that allow the instructions to be given. You can choose to print BAJl instructions on either Form 176 or
Form 177 as they are revised post-Judicial Council approved instructions.

You can set various printing options as you prefer(page 81), as well as change the default fonts for
the format (page 93).
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s OVERVIEW OF TRIAL
Instruction
No.101

Raguaesad by Pialers Faguanied by Deferdust O Feguented by o

Qiver: a1 Paguentd vt s MoGiSd [0 | e cecowraddaica 0

ket

Withdrens

OO0 |4g|o

Tnstnuction
No.101 Pags 1 of 2

To assist vou in your tasks as jurors, I will now explain how the wial will proceed. Name
of plamtiff filed this lawsuit. HeShe Tt 15 called a plamtiff. He/She/Tt seeks damages or other relief
from pame of defendant, who is called a defendant. Each plaintiff and each defendant is called a party
to the casa.

Fust, each sds may make an openmng statement, but newther side 1s requued to do so. An
openmg statement 1= not evidence. It is simply an cutline to belp you uaderstand what that party
expects the endeace will show. Also. because 1t 13 often difficulr to grve vou the evidence i the oeder
we would prafer, ths openmg statement allows yoa to keep an overview of the case m tmd during
the presentation of the evidence.

Next, the jury will hear the evidence. Name of plamtfY wiil present lns/herts evidence
first. When name of plamtiff ¢ fimshed, name of defendant wili have an opportunity fo present
his‘herits evideace.

Each witpess will first be questioned by the sides that asked the witness to testify. This s
called direct examinaton. Then the other side 15 permutted to question the wimess. This is called
Cros3-exammation

Documants or objacts rafarrad to during tha tmnal are callad axhibirs. Exhibits are given a
number/ieiter and marked so they may be clearly Weatified. Exhubuts are not evideace vatl I admut
them mto evidenca During vour Sehbérations, you will be able to look at all extubts admuted mto
evidence

There are many rules that govem whether sometaing will be considered evidance in the
tral. As one side presents evidence, the other sid« has the nght to obyect and to ask me to decide if
the evidence 1= permiited by the rules. Usually, 1 will decde sumediately, but sometmes | may have
to hear arguments outsida of your presaace

After the evidence bas been presented. I will instruct vou on the law thar applies to the
case and the attorneys will make closmg arguments. What the parties say m closmg argument is not
evidence The argumeats ars offerad o help you understand ths esadence and how the law apphes (o
it

RIDSE Rex 381465

Figure 6-8. Jury instruction printed in the Los Angeles County Forms 176/177 format

Booklet format

Use the Booklet format to printjury instructions as a booklet. This format is typically used for
providing instructions either from the party’s attorney to the presiding judge or from the court to the
jury.

The Bookletformat caninclude a Table of Contents, the instructions, an Index, and the Disposition
Table(page 91), in that order. Itis paginated in the order set on the Jury Instructions tab's
Chapters/Sort pageor as ordered on the Print tab's Choose Instructions page. Each instruction
numberis shown in the far left column and can include the instruction type (e.g., BAJI) with the
instruction number.

You can setvarious printing options as you prefer(page82), as well as change the default fonts fo
the format(page 93).

r
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TABLE OF CONTENTS
Case Neme SMITH VDOE
Case No: 233567
Instruction Header Page

PRETRIAL 1
EVIDENCE -
CONTRACTS 5

Figure 6-9. Table of Contents in the Booklet format

PRETRIAL

100 You have now been sworn as furors in this case. I want to impress on you the
senousness and mportance of serving on 3 jury. Tral by jury is a fundamental nght m Cadforna. The
parties have a right (0 2 jury (hat 13 seiscted faxly, that comes to tha case without bas, and that will
attemnpt to reach a verdict based on the evidence prasanted. Before we begmn, [ nead to axplam how
vou must conduct vourseives during the tral

Do not allow anvthmg that happens owtside this courtroom to affect vour decision
During the trial do not f@akk about this case or the people imvolved in 1t with anyone, mcluding family
and persons kving i your housshold, frisnds and coworkers, spmitual leaders, advisors, or
thaeapists Do not post any information abous the trial or your jury service on the Internst in any
form. Do not sead or accept any messages, including c-mail or text messages, to or from anyoae
concermmg Me tral or your serncs. You may 2y you are on 3 jury and low long fhs tnal may fakes,
Dut that 13 all. You must not even talk about the case with the other jurors untd after I tell vou that it
i3 ime for vou to decide the case.

Durme the trial you must pot listen to anyonie else talk about the case or the people
mvolved m the case. You must avoid any coatact with the parties, the lawvers, the witnesses, and
anyone else Who may have a connection to the case. If anyome tnes to talk to you about fhus cass,
11 that person that you cannot discuss i bacausa you are a juror. If hia or 3he keeps talkmg to vou,
simply walk away and report the incideat to the court arteadant baliff as soon as you can.

After the trial 1s over and I have released vou from jury duty, you may discuss the case
with anyone, but you are not required to do so

During the trial do not read, listen 0. 0 watch any news teports about this case. T have
10 information that there will be news reports conceming this case. You must decide this case based
only on the evidence presented in this tnal and the instructions of Law that I will provide. Nothing that
vou see, Tiear, 01 leam outaids fns courtroom 1= evidence uniless [ specifically tall yvou it 15 If you
receve any wformanton abowt Mes case from any source outade of the courtroom, prompily reportu
1o the court attendant/bailiff

Do not do any research on yous own of as a group. Do pot use dictonanies, the
Internet, oz other reference matenals. Do not mvestigate the case or conduct any experuments. Do
10t contact anvona 1o assist you, such as a famdy accountant. dector, or awver. Do not visit or view
the scene of any eveat involved in this case. If vou happen to pass by the scene, do not stop or
investigate. All jurors must se¢ or hear the same evidence at the same tme. If vou do need 1o view
the scene during the tnal, you will be taken there as 2 group under proper supervision

It 15 umportant that you keep an open mmd throughout this tnal Evidence can only be
preseated a precs af A teme Do not form or express an opmasa about fus case whils the mnal 45 gomg
on. You must aot decide on a verdict untl after vou have heard all the evidence and have discussed
1t thoroughly waith wour fellow jurors in vour deliberations.

Do not concern yourselves with the reasons for the rubngs [ will roake duning the course
of tha tnal. Do not gua3s what [ may think your verdict shouid be from anything I might say or do

Whea vou begin your deliberations, you may discuss the case only i the jury room and
onky when all the jurors are present.

You must decide what the facts are m thus case. And, I repeat, your verdict must be
basad only on the svidence that you heas or 388 m s courtroom. Do not let bas, sympathy.

1
Jucacial Council of Califormma Jury Instructions

Figure 6-10. Beginning of a chapter of jury instructions printed in the Booklet format
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prequdice, or public opiuen nfluence vour verdict
At the end of the tnal, I will explain the Jaw that you must follow to reach your verdict.
You must follow the law 2s I explain 1t to you, even if you do not agres with the law.

101 To 333138 YOU I Your tasks a3 jurorz, 1 will now explain how the tnal will procesd. Name
of plaintiff filed this wsuit. Be/ShaTtis called a plaintiff. He/She It seeks damages or other ratiaf
from name of defendant, who is called 2 defendant. Each plaintiff and cach defendant is called a
party to the case.

Furst, cach side may make an opening statement, but acther side is required to do so.

An opeaing statement is pot evideace. It is simply an outine to help vou understand what that party
expects the evidence will show. Also, because it 1s often dufficult to give vou the evidence m the
order we would prefer, the opening statement allow's you to keep an overview of the case m mmd
durmng the presentation of the evidence.

Next, the v will hear the evidence. Name of plamnft w1l preseat tosherats swdence
first. When nama of plamtiff is finsshad, name of dafendant Wil have an oppostunity o prasent
Tesherats endsnca

Fach witness will first be quastioned by the side that asked the witness to testfy. This is
called direct exanination. Then the othsr side 15 permittad to question the witness. This i calisd
Cross-examination.

Documents or objects referred to during the trial are called exhibirs. Exhibits are gpiven a
number/letter and marked so they may be clearly identified. Exhibits are not evidence until I admic
them into evidence. During vour delberations, vou will be able to look at all exhubits admitted wto
evidence

There are many rules that govern whether something will be considered evidence m the
tnal. As one side preseats evidence, the other side has the night to obyact and to ask me to decrde 1f
the evidence is permitted by the rules. Usually, [ will decide mnmediately, but sometimes 1 may have
10 bear argumesnts outsie of your presence

Afer the evidence has been presanted. T will instruct vou oa the law that applies to the
rase and the artornayz Wil make closing arguments. What the parnes say m closing argumsent 12 not
avidanca. The argumeats are offerad to halp you understand the evidence and how tha law applies
o it.

n this case. name of plaintiff claims msert description of the elements of plzintiff's claim
{s). Name of defendant claims insert description of the clements of defendant's affirmatve defense(s)
and‘or cross-complaint.

102 Yoo have beea given notebooks mnd tmay taks notes dining the tial Do not take the
N0tebooks put of Me Courtzom of Jury room at any tme dunng e trial You may take your notes
into the purv room dunng deliberations.

You shouald use your notes only 1o remind yourself of what happenad dunng the tal Do
not let your note-taking interfare with your ability to listen carefully to 2l the testimony and to watch
the witnesses as they testfv. Nor should vou allow vour impression of a witness or other evidence to
be influenced by whether or not othier furors are taking notes. Your independent recollection of the
evidence should govern vour verdict, and you should not allow vourself to be influeaced by the notes
of other Jurors if those notes differ from what vou remember.

The court reporter ts making a record of everyihing that 1s sad. If durmg delberabons

2
Judicial Council of California Jury Instructions

Figure 6-11. Continuation of the same chapter of jury instructions printed in the Booklet format
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INDEX
Case Name: SMITHVDOE
Cize No: 234567
Inst. ¥ Lustruction Header Page
PRETRIAL

100 PRELIMINARY ADMIONITIONS 1
101 OVERVIEW OF TRIAL
102 TAKING NOTES DURNG THE TRIAL 2
106 EVIDENCE

107 WITNESSES

[N

w

L

108 DUTY TO ABIDE BY TRANSLATION PROVICED N COURT B
111 INSTRUCTION TO ALTERNATE JURORS 4
112 QUESTIONS FROM JURORS 4
EVIDENCE
202 DIRECT AND INDIRECT EVIDENCE 4
205 FAILURE TO EXPLAIN OR DENY EVIDENCE 5
206 EVIDENCE ADMITTED FOR LIMITED PURPOSE £
CONTRACTS
J2z QCCURRENCE OF AGREED CONDITION PRECEDENT 5

Figure 6-12. Index in the Booklet format
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Pleading format

Use the Pleading format to prepare a pleading to request jury instructions.

You can setvarious printing options as you prefer(page 84), as well as change the default fonts for
the format(page 93).

1] Jeffrey Sweet. Bar No. 1234567
Swest and Henderson

51 State Street

Sacramento. CA 95814

)

e e
g
w
i
o
h
wn
o
1
—
o
o
"~

Fax. 555-555-8850
Emait JSweet@ SweetHenderson.com
6| Attorney for: Plaintiff Robert Smath

h

SUPERIOR COURT OF THE STATE OF CALIFORNIA

g
6 COUNTY OF SACRAMENTO
Robert Smith, Case No.234367
© Plaintiff,
11 REQUEST FOR JURY INSTRUCTIONS
{Code Civ. Proc. § 607a)
12) vs.
13| Marjonie Doe, Judge: R Frederickson
14 Defeadant, Dept.:
Trial Date: 2/4/2008

13

15| Plaintff Robert Smith respecdully requests this court to grve the following menbered Jodicial
17| Comncil of Calfornia Cwil Jury Instructions, and the additional instructions set forth below, and
18] any further or additional mstructions that may be subsequently requested:

20) CACI202, CACT 205, CACI 206

21 Dated 2/7.2008 Sweet and Henderson

22 By

23 Jeffrey Sweet

24 Atteaney for: Plantiff Robert Smith
25

26

27

28

Figure 6-13. A request for jury instructionsin the Pleading format

Disposition Table

Some of the print formats give you the option of including the Disposition Table (Figure 6-14). This
table provides an "at-a-glance" view of the Requested-By flags and Status flags of the Selected
Instructions. You can quickly see who requested which instructions (Plaintiff, Defendant, Court, or
Other), how those instructions will be given to the jury (Given as Requested or Given as Modified), and
whether any instructions have been refused or withdrawn. Additionally, the print date of each
instruction is listed.

The Disposition Table always appears on its own page, regardless of the print formatin use.
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NOTE: Inolderversions of Jury Instruction Selector, the Disposition Tablewas known as the History
Index. We've retained that term in the program for the convenience of long-time users.

DISPOSITION TABLE
Casa Name:  Smith v Doe
Case Number. 234567
Data: 2/4.2010
Instruchion / Requested By Ghven as Rt mﬂ\-

Special Verdict #  [PIef [Dide| Crt |Oth Namelz) Req Mod|nsed Print Date
CACI 100 12/2007
CACI101 22007
CACI 102 122007
CACI 106 0005
CACI 107 2 e
CACT 108 3 PR
CACIIT 1012008
caciin s
CACIIM 9/2003
CREs X Defendant Masjorie Doe X 10/2004
CACI 205 /2003

Bh
i 9/2003
CACIN T
Judicral Councyl of Californza Jury Instruchions

Figure 6-14. Disposition Table
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Set up the default printer

Use the following procedure to select the program's default printer and various default print options
used for printing instructions.
To set up the default printer

1. Choose File > Print Setup.
The Print Setup window opens.

Prirder
Name: p Laserlet 1300 PLLS
Satus:  Ready
Type: np Laasandet 1300 PCLE
Whare:  USBO04
Commert.
~Pzper Dnentation
S |Letler ~| & Poerat
Source: | faicraiicaly Sedect ~ € Londscope
Network . | [ ok | camcs |

2. From the Name drop-down list, select the printer you want to set as the default forthe
program.

3. Setthe Paper options and Orientation option as desired. (If necessary, you can access printer-

specific options by clicking the Propertiesbutton to open the Properties window for the
selected printer.)

4. Click OK to save andclose.

Set the default fonts for printing

Genenally speaking, the default fonts used in printed instructions are 12 pt. Helvetica, Times New
Roman, or Arial regularand bold. If thecourt allows you to use different fonts, you can change the
font preferences. You can set up different preferences foreach format (e.g., Booklet).

To set the d efault fonts for printing

1. On the Print tab, go to the pageforthefommat (such as Booklet) whose default fonts you
wantto set

2. Onthetab toolbar, click k Edit Fonts.
The Edit Fonts window (specific to the format you selected) opens.
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Booklet Format Fonts
Chapler hitle
112 pe. Timas New Roman Choose Font
Instruction header
{10 ot Arol Choose Fent ..
Inatruction text
iiZ pt. Times New Roman Chooae Fort ..
Page number
{12 pt. Timas Naw Ronuan Choosze Font .. |
Reatore Defaults
[ ok | canca | 2|

3. Foreach component whose font you want to change, do the following:

a. Click Choose Font.
A standard Windows Font window opens (not illustrated).

b. Change the font settings as desired.
c. Click OK to save andclose.

4. Whenfinished setting the default fonts, click OK on the Edit Fonts window to save and close.

Set the default print-to-file file type

With Jury Instruction Selector, you can "print" jury instructions to a word processing file (either
Microsoft Word or Corel WordPerfect) or to a PDF file. Use the following procedure to specify the
default file type you wantthe program use. (Forinstructions on printing to afile, see page 97.)

To specify the default print-to-file file type
1. Click | Options on themain toolbar, or choose Settings > Options.
The Options window opens.

2. Switch to the Other tab.

3. Inthe Print to File section, selectyour preferred file type from the Default File Type drop-down
list. Also, if you want always to view documents after the program creates them, select the
Always open docume nts before saving check box.
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Courts 3 Atomey | Dispsy | Book Criapters | Alerts  Cther |
Print to File

DefautFleTyps  |Wcmsoft Word Document |
[T Always open documents after saving

Flle Recovery
|7 Enasble Fi= Recovary

|f - I nmina
Default Save/Load location:
[caprmm Flea\WeatJury katruction Salechonuesr Choos= Locaton... l

T | o |

s

4. Click OK to save andclose.

Choose instructions for printing

Thefirst step in getting ready to print jury instructions is to select which ones you want to print,
including refused and withdrawn instructions. You do this on the Print tab's Choose Instructions

page.

To choose instructions for printing

1. On the Print tab, go to the Choose Instructions page.
Thelists at the left show the Selected Instructions (including refused and withdrawn ones),
while the list at the right shows what will beyourprint list.

2. Selecttheinstructions you wantto include and, if desired, arrmangethem in the orderin which
you want them to print. Use the following techniques:

o Use Add Selected to add selected instructions from the Available Instructions list
and/or Refused/Withdrawn Instructions list to the Included Instructions list. Use Add
All to add all of theinstructions to the Included Instructions list.

NOTE: By default, only the titles of included refused and withdrawn will be printed. If
you want to print the text of these instructions, select the Print text of refused /
withdrawn instructions check box.

¢ Use Remove Selected, Remove All, and Remove Ref/Wdrn to remove individual or
all instructions from the Included Instructions list.

e Torearrangethe orderof the included instructions, use the Move buttons
Il 2% I i | !I . To re-sort the instructions in numeric order, use Re-sort in

Numeric Order. (Yourorder of instructions here overrides the order of instructions on
the Jury Instructions tab's Chapters/Sort page for this printing only.)

3. Whenfinished selecting, you are ready to select the format and setits various options. See
"Setformatoptions forthe print job," next page.
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Set format options for the print job

Thesecond step in getting ready to print jury instructions (after choosing instructions to include; see
previous page) is to setthe options forthe desired format. You do this on one of the format pages of
the Print tab.

To set format options for the print job

1. On the Print tab, select the page of the formatyou want to use, such as Single Page or
Booklet.

2. As desired, set the options on the format's page:
o Single Page page (page 80)
o L.A.County Forms page(page 81)
o Booklet page (page82)
o Pleading page (page 84)

You are now ready to print, preview, or print the instructions to a file.

Print jury instructions

Use the following procedure to printyour jury instructions.

To print jury instructions

1. Choosewhich instructions you want to print (see previous page) and set format options (see
above).

2. Click é Print on the page toolbar of the print formatyou selected. For the Single Page, Los
Angeles County, and Booklet formats, a message appears to ask you to confimm thatyou want
toremove brackets and bracketed text. Respond as needed.

TheRemove Drackels fealure will delete all square brackets = []
\l-) framthe insiruchiontext Itwillalzo delezzall angle bracksts, (e, <=

and any text that sppears Insidetnsm, 53 surs vouhave mads all
necassary changes tathe Instruction taxt befareconinuing

™ Inshetuture. donotshow this messags.

oK Gancel
| | |

A standard Windows Print window opens (not illustrated).

3. Select printoptions (e.g., number of copies, printrange) as needed and click OK.

Preview before printing

Use the following procedure to preview your jury instructions before printing them.

To preview instructions before printing

1. Choosewhich instructions you want to preview (see previous page) and set format options
(seeabove).

2. When ready to preview, click @ Print Preview on the tab's toolbar.
The print preview window opens.
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_

& Cow | TN w[¢] P aimf [ oo | @

CACI 100. PRELIMINARY ADMONITIONS

Feqauted by Plantes Feguested by Defundars | Ragaested by

[ O O
Caven @ Fagaeted D Givez o Modfied D Grven on Coust's Meten D
lafroed O
Withdaen | Judge
Frnt date: 122007

You have now been swam as pxors m this case 1 want to mpress on you the senousness and
importance of serving on a jry. Trial by jury 55 a fandamental night & Calfornia. The parties bave a
right to a jury that is selected fanly. that comes to the case without bias. and that will attempt 10
teach a verdict based om the evidence prescned Before we begm. 1 need to explain how vou minst
conduct yoursehves ding the trial.

Use the print preview window’s toolbar buttons to navigate through the document. (You can
also printit from this window, if desired.)

Click Close to close the preview window.

Print instructions to a file

Use the following procedures to "print' your jury instructions to a word processing or PDF document.

NOTE: If you print instructions using Bookletformatto a word processing fileand elect to include a
Table of Contents and/or Index, the pagenumbers will not appear to be present when the file is first
generated. However, it is easy to reveal the page numbers, using your word processor's specific
features. See the FAQ "Where are the page numbers in the Table of Contents or Indexin my RTF

file?" inthe Help system.

To printto afile

1.

If you havenotalready set up your preferred print-to-filefiletype, see"Set the default print-to-
filefiletype," page 94 before continuing.

Choose which instructions you want to print (see page 95) and setformat options (see
previous page).

Click Print to File on the tab's toolbar.
The Print to File window opens.

Specity the Oulput Options

Output Options;

File Name | Browse . I

[T Dpenthe assembled documentinmy default word proc=ssor

[ ] e | 3
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4. Inthe File Name box, type the name of the fileyou want to create. (The file will besaved to the
default save location, but if you wish to save it elsewhere, use the Browse button to navigate
to a different location.)

5. Ifthefilewill besaved as a word processing file and if you'd like to view it right away, select
the Open the assembled document in my default word processorcheck box.

6. When ready, click OK.

Print an individual instruction

Use the following procedure to print the text of an individual Master Instruction or Selected
Instruction. You might find it especially useful to print an edited Selected Instruction to review it with a
relevant party.

To print aninstruction's text

1. View the MasterInstruction (page 59) oropen the Selected Instruction for editing (page 64).

2. Click é Print Text on the window's toolbar. If you are trying to print a Master Instruction,
the Print Text window (not illustrated) opens so you can specify if you wantto print the
instruction only, the Commentary only, or both.

Print an instruction's Commentary

Use the following procedure to print an instruction's Commentary.

To print an instruction's Commentary
1. Viewan instruction's Commentary (page 60).

2. Click é | Print Text on the window's toolbar. The Print Text window (notillustrated) opens
so you can specify if you want to print the instruction only, the Commentary only, or both.

Print a list of instructions

Use the following procedure to print a list of Master Instructions, Selected Instructions, or Personal
Instructions. (Alternatively, you can elect to preview the list or print the list to a file.)

NOTE: To printthe MasterInstructions for civil cases, be sure that a civil-caseinstruction fileis
open. To print Master Instructions for criminal cases, be sure that a criminal-case instruction fileis
open.

To print a list of instructions

1. Onany page of the Jury Instructions tab, click é Print Instruction List, orchoose File >
Print Instruction List.
The Print Instruction List window opens.

98 California Jury Instruction Selector User Guide (Version 6.1)



Chapter 6. Printing Jury Instructions
Print a list of instructions

Page Sellings Included Instructions
™ 'li'g";"_’ll'] Which st would you He to print?

W Pago focter {* Maatar nstructon List

= g g sruction numbe N
M Use onginaly dernac parsonal matruction numbsrs C - Saea .
I Use custom footar

l

(" Persoral Instructons

Frediew | Pt | Pt concel | d

2. Select the desired page settings.
3. Select which instructions you wantto include, e.g, Selected Instructions.

4. Click Preview, Print, or Print to File as desired.

California Jury Instruction Selector User Guide (Version 6.1) 99



Chapter 6. Printing Jury Instructions
Print a list of instructions

100 California Jury Instruction Selector User Guide (Version 6.1)



CHAPTER /. CREATING PERSONAL
INSTRUCTIONS

This chapterexplains how to create custom instructions, called Personal Instructions. Once created, they can be selected
for inclusion in an instruction file and edited with case information just the same as Selected Instructions based on Master
Instructions.

About Personal INSTrUCtIONS - -« c o e e e e e e e et e et e e e e e e e e e e e eme e e e e e e ——nn—an 101
Start a New Personal INSTrUCHION .uuueeeseeeeeseeesesesensssssnsasssesasssassasssssasnssssssnassansnassanenns 101
OpenaPersonal Instruction for e diting - .- - oo oo oo et e et 103
Define the text of the Personal INStruction - - - -« oo ettt eiaeiieeeaeeaaas 104
Add auto-populatefields to a Personal Instruction .. .. ... i 106
Add gender phrases to a Personal InStruction - . ... ... o e 107
Edit the title, header, and/or authorities of a Personal Instruction ... ... e e 108
Delete a Personal Instruction sz s s st s i s e e T S A S S e S S B S e 109

Renumber a Personal Instruction

About Personal Instructions

Personal Instructions are custom instructions created by Jury Instruction Selector users. They are
similar to MasterInstructions in that, oncecreated, they can beselected forinclusion in any
instruction file. They can include bracketed text and blanks, auto-populate fields, and even gender
phrases such as "he/she." Onceselected forinclusion in aninstruction set, a Personal Instruction can
beedited justlike any other Selected Instruction.

But Personal Instructions differin these ways:
o Their"masterversions" can be edited (with the exception of their numbers).
o They have no Commentaries (although they may have authorities).

e They arenotincluded in any searches conducted with the Search feature.

NOTE: Afteradding Personal Instructions, and assuming that you will wantto use the Booklet
format for printing, consider adding a default chapterto contain them. For more information, "Setup
chapter defaults," page 23. For more information on the Booklet format, see "Bookletformat," page
87 and "Booklet page " page82.

Start a new Personal Instruction

Jury Instruction Selectordifferentiates between civil Personal Instructions and criminal Personal
Instructions. Before starting a new Personal Instruction, be sureto open a case of the type you want
the Personal Instruction to be. For example, to start a civil Personal Instruction, be sure that a civil
caseisopen.ltdoesn't matter whether or notyou want to select the new Personal Instruction for
inclusion inthe opencase
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To start a new Personal Instruction

1.

Opena case of the type (e.g., civil or criminal) for which you wantto createa Personal
Instruction.

2. Go tothe Jury Instructions tab's Personal Instructions page.

3. Click D New Personal Instruction on the page's toolbar.

The New Instruction window opens, over which is imposed the Instruction Information
window.

Enter the information for this instruction below

Instructian Informetion
instructian ?:ﬁ

Titles

—

Header:
Line 1:|

Ling 2:
Line 3:

Line 4

Authonties:

In the Instruction # box, type a unique number (up to 10 characters) that will identify this
Personal Instruction. The defaultis USER.A. The numberyou entercannotduplicate the
instruction number of an existing Master Instruction or Personal Instruction. Once you save the
instruction, you will not be able to edit this number.

NOTE:

(1) Werecommend that you begin a Personal Instruction's number with a letter in orderto
avoid any numbering conflict when new Master Instructions areadded to Jury Instruction
Selector, although this is not a requirement. In the event that a Master Instruction added in a
future version of the program has the same number as a Personal Instruction, you will not be
abletoselect both instructions forinclusion in the sameinstruction set. Youshould recreate
the Personal Instruction with a new unique number. (See "Renumber a Personal Instruction,"
page110.)

(2) If you plan to print a group of Personal Instructions in one chapterof a booklet of jury
instructions, give them similar numbers. Chapters are printed by a range of numbers, not by
individual instruction numbers.

In the Title box, type the title of the Personal Instruction. This title will appears in the title bar
of thewindow in which the instruction is viewed or edited.

In the Header: Line 1box, type the header of the Personal Instruction. This headerwill appear
in the instruction's row on pages of the Jury Instructions tab. (You may enter up to three more
lines for the header.)

Authorities are needed only for instructions that will be printed on Form 176. To add
authorities, type the applicable citation in the Authorities box, such as "Smith v. Covell (1980)
100 Cal.App.3d 947, 960 [161 Cal.Rptr. 377]" as it will appear in the Authorities box on Form
176.
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8. Click OK to save andclose.
You are now ready to define the text of the Personal Instruction. (See "Define the text of the
Personal Instruction," next page.)

Open a Personal Instruction for editing

Unlike MasterInstructions, whose "mastertext" cannot be edited, youcan edit the masterversionof a
Personal Instruction.

NOTE: If the Personal Instruction has been selected forinclusionin any instruction sets, the Selected
Instruction versions of the instruction will not be affected by your edits. You may need to deselect
and reselect the instruction in those instruction sets to ensure that they include the most up-to-date
version.

Toopen a Personal Instruction for editing

1. Open a case of the type (e.g., civil or criminal) thatis the same as the type of Personal
Instruction you wantto edit.

2. Go tothe Jury Instructions tab's Personal Instructions page.

3. Highlightthe Personal Instruction you wantto edit. (Don'tclick it, as that will select/deselect

itforthe open case.) Click @ Edit Personal Instruction on the page's toolbar.
Aninformation message appears to remind you that you are about to edit the master version
of theinstruction. Click OK to dismiss the message.

- Changes made here will affect anly the mastertext of thisinstruction, 3f
\l) necessary, update thetext of previous instruction sets by desdating
and reselecting thisinstructon

[ inthefiuture, do notshowthic messace

[ | cancel | 2]

4. On theEdit window that opens, you may now edit the Personal Instruction, using the
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techniques covered elsewhere in this chapter.

Fls Edt Vew Toos Hep

E[B% m & ¥ il |[on %9 5Kk mE || )

BITING POLIE DOG CAUSING IRIURY

| Police dogs are trained to bite suspects unless a countermanding order is given by the bandler. However,
when 2 dog 13 sent to locate 2 concealed uspect, the dog would almost neceszsity be ot of zght of 1ts bandlee,
and henoe beyond the reach of a countermanding order. In addition, 1f @ sagpect attempts to elude the dog’s bite
nnatead of passvely allowiag the animal to mantain 1ts bold, the dog may repeatadly ets the suspect 10 an afYort to
obtain a sustained grip with its jaws

[n many cases the dogs would be out of 2ght of their handlers, aad that sedeneg the handlers o mantsnn
copstant survetllance over their ammals smply would not be feashie. Therefore, the actions of the police dog may
be the dog's own and are not nacessanity under the 1aflusacs of the handier.

£t Insmuctien hio... ] _?J

Define the text of the Personal Instruction

To definethe text of a Personal Instruction, you can type directly in the New Instruction window or
Edit window, oryou can paste in text from elsewhere. You can even include blanks in an instruction
wheretextis to supplied for a specific case.

TIP: You might find it convenient to compose the text with a word processor and then copy and
paste the text into the Personal Instruction.
To define the text of a Personal Instruction
1. Do either of the following:
o Open a Personal Instruction for editing (previous page). The Edit window will be open.

o Starta new Personal Instruction (page101) and define the instruction information.
Whenyou havefinished that, the New Instruction window will be open.

The two windows are essentially identical.
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B BY 3 8 v o[ %Y 8% mg )

BITING POLICE DOG CAUSING INJURY

K]

2. Type orpaste theinstruction's text. It's good practiceto include a tab spaceat the beginning
of each paragraph. Also, you caninclude blanks (created by pressing Shift —) up to 20
characters long wheretext is to be supplied later.

RE
3. Tocheckyourspelling, click V}) Spell Checkto open the Spell Checker window. (For
details, see"Check spelling," page 69.)

4. To add an auto-populate field from the program's collection of suchfields, click % | Add
Auto-Populate Tag to open the Add an Auto-Populate Field window. (For details, see"Add
auto-populate fields to a Personal Instruction," next page.)

5. To add a genderphrase such as "he/she" click 5{5 | Add Gender Tag to open the Add
Gender Phrase window. (For details, see "Add gender phrases to a Personal Instruction,"
page107.)

6. Tosavetheinstructiontext, click n | Save.

o Ifthis is an existing instruction, the Edit window remains open so you can make more
edits. (To close the window, click.)

o Ifthisis a newinstruction, the New Instruction window closes, and a confimation
messageappears to ask if you want to select the instruction forthe open case.
Respond appropriately.

@ Would you like to select the new instruction?
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Add auto-populate fields to a Personal Instruction

You can easily add auto-populate fields from the program's collection of fields to a Personal
Instruction.

When the Personal Instructionis selected forinclusion in an instruction set, the Auto-Populate feature
can be used to populate the fields with the appropriate case information. (If you add auto-populate
fields for parties (People and Entities), consider also adding gender phrases. See "Add gender phrases
to a Personal Instruction," facing page.)

To add an auto-populate field to a Personal Instruction

1. Ifyou are editing an existing Personal Instruction, the Edit window will be open. If you are
creating a new Personal Instruction, the New Instruction window will be open. The two
windows are essentially identical.

2. Position the insertion marker where you wantto place the auto-populate field. If you
inadvertently position it within another auto-populatefield, a warning message appears. Click
OK to dismiss themessage and reposition the insertion marker.

!‘ ’ Yaucannatinsertafield inside anctherfield Pleassplace the newfeld

alsdifferent posidion crremov e the Auto Populate feature from the
desited locaion

(===

3. Click %l Add Auto-Populate Tag on the window's toolbar.
The Add an Auto-Populate Field window opens, showing the different types of fields at the
left.

4. Expandthetype of field youwantto add, such as Crimes and Acts. Then select a specific field,
such as Conduct.
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ChooseRale

[+]- Feopks ena Enbtize
[#] Party Typss
] Crimse and Acta
i i Acyscton
- Activity
i [
- Misconduct
B)- Dates
- Property, lems, Locations
Usc=laneous

Enter Visibie Text:

Pravien:
Please sclect a ficld from the kat
l Insen Text I Cancei | ?I

In the Enter Visible Text field, type the field's text asyou want it to appear in the instruction.
The Preview area shows how the field will appear in the instruction.

NOTE: As a best practice, werecommend that this text indicate the pumposeof thefield and
that you frame the text with brackets. For example, if you wereinserting the Conduct field, the
visible text should be something like "[nature of conduct]" or "[criminal conduct]".

When ready to add the field to the instruction, click Insert Text.
The auto-populatefield is added to theinstruction.

TIP: If you added a People and Entities field, also consider adding gender phrases to the
instruction. (See "Add gender phrases to a Personal Instruction," below.)

Click E | Save to saveyouredits.

Add gender phrases to a Personal Instruction

You can easily add gender phrases such as "he/she" to a Personal Instruction. Gender phrases are
another form of auto-populatefields, and you should add them wheneveryou've also added auto-
populate fields for parties (persons and entities). When the Personal Instruction is selected for
inclusion in aninstruction set, the Auto-Populate feature can be used to replace the gender phrases
with the proper wording, based on the parties' roles.

To add a gender phrase to a Personal Instruction

1.

If you are creating a new Personal Instruction, the New Instruction window will be open. If
you areediting an existing Personal Instruction, the Edit window will be open. The two
windows are essentially identical.

Position the insertion marker whereyou want to place the gender phrase. If you inadvertently
position it within another auto-populate field, a waming message appears. Click OK to
dismiss the messageand reposition the insertion marker.

California Jury Instruction Selector User Guide (Version 6.1)

107



Chapter 7. Creating Personal Instructions
Edit the title, header, and/or authorities of a Personal Instruction

s Yaucannaotinsertafield insideanotherfield Pleassplace the newfeld
\y aladifferent posdion orramov e the Auto Populale feature from the
desited locaion

(=]

3. Click %I Add Gender Tag on the window's toolbar.
The Add Gender Phrase window opens, showing the different types of fields at the left.

ChopsezRale Choose Genders

Accompice -
Actor—-frst ] Male Eamaia Entity Group
Aclor—sccond " he O she i 7 they
Agency

Agency—employng peace offcer
Agency--emoloyng poiice offices  nis  ners C s " them
Agency-—-emoloyng oublc officer

Agent L
Companant

Candemnor

SR, C himsell € herself C theirs
Coparbicipant
Count
De=bior ™~ themselves
Dacadan!
Defendant
Defendant-corporsie [T Make Uspercase
Defendant-—-employse

De'emm‘-mmyaf Previen:

m

C him  ner  itssir " thair

Defencani-first Gender Preview
Defendant—frst empoyer

Defendant—hos pital | insern Text I el I ?I

[Defendant—-nonseting
Defendant-.s2cond smployer ¥

4. Fromthe Choose Role list, select the role for which you wantto add a gender phrase.

5. Under Choose Genders, select all of the words you wantto includein the gender phrase. The
program will separate them with slashes. For instance, to achieve "he/she," select he and she.
The Preview area shows how the gender phrase will appear in the instruction.

6. Ifthe words should be uppercase, such as forthe beginning of a sentence, select Make
Uppercase.

7. When ready to insert the phrase into the instruction, click Insert Text.
Thegender phrase is added to the instruction.

8. Click m | Save to saveyour edits.

Edit the title, header, and/or authorities of a Personal Instruction

You can edit the title, header, and/or authorities of a Personal Instruction (but not its instruction
number).

NOTE: If the Personal Instruction has been selected forinclusionin any instruction sets, the Selected
Instruction versions of the instruction will not be affected by your edits. You may need to deselect
and reselect the instruction in those instruction sets to ensure that they include the most up-to-date
version.
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Delete a Personal Instruction

To edit the title, header, and/or authorities of a Personal Instruction

1. Openthe Personal Instruction forediting. (See page 103.)

2. On the Edit window, click Edit Instruction Info.
The Instruction Information window opens.

Enter the information for this inztruction below,

Instruction Information

instructian ::F‘-'n' 1
Titie: [POLICE DOG BITES)
Header:

Line 1: ?ITFKS POLICE DDG CAUSING INJURY

Ling 2|

Line 3:

.. |

Authonties:

3. Editany of thefields as needed.
4. Click OK to save andclose.

Delete a Personal Instruction

You may delete any Personal Instruction from Jury Instruction Selector's database. Bearin mind that
you will be deleting the master version of the Personal Instruction so thatit will no longer be
availableforuseinanyinstruction sets.

NOTE: If the Personal Instruction is currently selected in the open instruction file, deleting it will
automatically removeit from thefileas well. However, if it is included itin any othersaved filg, it
will remain in thosefiles. If you open one of those files, the deleted Personal Instruction will be
added backinto the Personal Instructions.

To delete a Personal Instruction

1. On the JuryInstructiontab's Personal Instruction page, highlight the Personal Instruction
you want to delete.

2. Click m Delete Instruction on the page's toolbar.
Aninformation message appears.

i ’ Deleting a peisanalinsiruch onwill removeitfrom the persoral

instruction st However, the deleted instruchonwill reappsar fyou
ogsnasavadinstruciion setatincludesths aelstad Instructon.
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Renumber a Personal Instruction

3. Click OK to dismiss the message.
The Personal Instructionis now deleted from thedatabase. If it had been includedin the open
instructionfile, it is removed from it as well.

Renumber a Personal Instruction

With each new version of Jury Instruction Selector, new Master Instructions may have been added to
the program's database. When that happens, itis possible that a new Master Instruction's number
might now conflict with an existing Personal Instruction's number. In the event that you try to include
a MasterlInstruction and Personal Instruction with the same number in the sameinstruction file the
program will display an eror message and will not allow you to select the second instruction.

Thesolutionto this situation is to assign a new numberto the Personal Instruction. However, strictly
speaking, itis not possible to renumber an existing Personal Instruction. Instead, you need to recreate
the Personallnstruction as a new instruction with a new uniquenumber and then delete the old
version.You can thenselect the new version forinclusion in yourinstruction file.

To renumber a Personal Instruction

1. Openthe masterversion of theold Personal Instruction as if to editit. Selectall of its text and
copy that text elsewhere fortemporary holding, such as in a text fileor a word processingfile.
Also click the Edit Instruction Info button to open the Instruction Information window, where
the instruction's title, header, and authorities are stored. Copy the text of these items also to
the temporary holding file. Close the Personal Instruction.

NOTE: If the instruction included any auto-populate fields and/or gender phrases, those
items will be "flattened" to become only text. You will need to recreate them in the new
instruction.

2. Createa new Personal Instruction. On the Instruction Information window, assign the
instruction a new, unique number. Pastein the title, header, and authorities from the
temporary holding file. On the New Instruction window, paste in the instruction text from the
temporary holding file. In needed, recreate any auto-populatefields and/or gender phrases.
Save and close the new Personal Instruction.

This new Personallnstructionis now availableforselection forinclusion in yourinstruction
file.

3. Deletethe old Personal Instruction.
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A

accessing Westlaw, 30
account information, viii
Acts page (Case Informationtab), 47
Add an Auto-Populate Field window, 107
Add Authorities button, 71-72
Add button, 69-70
Add Chapter window, 28
Add Gender Phrase window, 108
Add Party, 44
adding
auto-populate fields to PersonalInstructions, 106-107
default chapters, 27-28
gender phrases to Personallnstructions, 107-108
instructions to instruction file, 61
text of Personal Instruction, 104-105
Alerts tab (Options window), 20
appending Commentary text to aninstruction, 71-72
assigning
Requested-Byflags, 77
Status flags, 77-78
assistance from West, viii
attorneys
defaults, 18
authorities
adding to a Selected Instruction, 71-72
in Personalinstructions, 108
Auto-Populate
best practice, 44
auto-populate fields
addingto Personal Instructions, 105-107
preview balloans, 59, 66
auto-populating instructions, 65-66
AutoSave, 21

B

BAJI-CACI Conversion Tablecommand, 32
BAJI Appendices command, 31
Best Practice

exclude party information from Auto-Populate, 44
blanks, 67-68
bold to showcase information, 23
Book Chapters tab (Options window), 27
Booklet format, 82

chapters in, 24

illustrated, 87

Indexin, 90

instructions in, 88-89

print options, 83

reordering chapters, 73-74

restoringdefaults, 30

Table of Contents in, 83, 88, 97
Bodklet page (Print tab), 82
brackets, 67-68

auto-populating, 65
Brackets and Blanks Review button, 67
browsers, 2

Index e A-C

C

CA Jury Instruction Selector.msi, 2
CA Rules o Court, Rules 2.1050, 2.1055 command, 31-32
CACI No.1700 Tables command, 32
CACI No. 3100Tables command, 32
CACI No. 3900 Tables command, 32
CACI Preface command, 31
CALCRIM Preface command, 32
CALJIC-CALCRIM Conversion Tablecommand, 33
CALJIC Appendices command, 32
canceling installation, 3
case information
inserting automatically, 65
looking up whereused in Selected Instructions, 51
overview, 41
showin bold, 23
Caselnformation Lookup window, 51
Case Informationtab, 15, 41-42
Acts page, 47
Court & Attorney page, 42-43
Dates page, 48
Items & Locations page, 49
Miscellaneous page, 50
Parties page, 43-44
Party Types page, 46
caselaw, links to, 60
Casename, 42
Case number, 42
CD-ROMdrive requirements, 2
CD-ROM installation, 3
ChangeAll button, 69-70
Changebutton, 69-70
Change Network Database Folder window, 10
changing
location wherefiles are saved, 36
order of chapters, 73-74
chapters
default for civilinstructions, 24
default for criminalinstructions, 26
defined, 24
deleting from bodklets, 29
editing default title of, 28-29
editing titleassociatedwith Selected Instruction, 74-75
opening for modifying defaults, 27
order of, 73-74
reordering, 73-74
restoring defaults, 30
restoring order, 76
restoring titles, 76
start and end instructions in, 27-29
working with, 23
Chapters/Sort page(Jury Instructions tab), 55-56
check marks, 61
checking spelling, 69-70
Choase Inst ructions page(Print tab), 80, 95
Choosethe display size ofthe instruction set, 23
Choose which set of instructions to display first, 23
choosinginstructions for printing, 95
Citrix, viii, 2
civilinstructions
chapter defaults, 24
civil reference materials, 31
Close button, 39
Closecommand, 39
closing
instruction files, 39
Jury Instruction Selector, 33
Commentaries, 60
printing Commentaries, 98
searching for text, 57
companion resources, Vii
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compatibility with various operating sys tems, viii, 2

conflicting instruction numbers, 110
context-sensitive Help, 17
converting, 72

instructions to verdicts, 72
cookies, 2
cookies, browser, 2
Corel WordPerfect, 94, 97

Court & Attorney page(Case Information tab), 42-43

Court command, 77
Court flag, 76-77
courts

default courts, 18
Courts & Attorney tab (Options window), 19
criminalinstructions

chapter defaults, 26
criminalreference materials, 32
custom instructions, 101
Customer Information window, 5
cus tomer service, ii, viii
customer support, ii
Customer Technical Support, vii

D

Dates page (Case Information tab), 48
default chapters
adding, 27-28
deleting, 29
editing, 28-29
ofcivilinstructions, 24
ofcriminalinstructions, 26
restoring, 30
default fonts, setting, 93
Default Save/Load Location box, 21
defaults
courts, 18
districts, 18
firms, 18
print-to-file file type, 94-95
printer, 93
savelocation, 21
Defendant command, 77
Defendant flag, 76-77
defining text of Personal Instruction, 104-105
Delete Chapterbutton, 29
deleting
default chapters, 29
instruction files, 39
instructions from instruction sets, 73
Jury Instruction Selector files, 11
Personal Instructions, 109-110
Department, 42
Destination Folder window, 6, 8, 10
dictionaries, 69-70
Disclaimer window, 4
disk spacerequirements, 2
display options, 22
Display Startup Options windowcheck box, 20
Display tab (Options window), 23
Disposition Table, 91
illustrated, 92
Disposition Table command, 32-33
distribution, network, 3
District and Court, 42
districts, 18
Division Title, 42
downloading webupdates, ix, 11

E

Edit Address window, 19

Edit Chapter Title for Selected Inst ruction window, 75

Edit Chapter window, 29

Edit District and Court window, 19

Edit Fonts window, 94

Edit window
pertaining to Personall nstruction, 104
pertaining to Selected Instruction, 64

editing
default chapters, 28-29
Personallnstructions, 103-104,108-109
Selected Instruction's associatedc hapter title, 74-75
Selected Instructions, 64-65

email notifications for updates, ix, 11

Enable FileRecovery, 21-22

endinstruction inachapter, 27-29

Exit button, 33

Exit command, 33

exiting Jury Instruction Selector, 33

F

feedback, send, ix, 18
fields, auto-populate, 65
fileformats, 35
file names
newfiles, 36
renaming files, 37
FileRecovery, 21
Finding Aids command, 32-33
Firefox, 2
First Pagebutton, 96-97
flags
assigning, 77-78
defined, 76
removing, 77-78
Requested-By flags, 76, 91
Status flags, 76-77, 91
fonts, setting defaults for printing, 93
Form176/177, 86
formats, print, 85, 96

G

gender phrases, 105
adding to Personallnstructions, 107-108
getting
assistance fromWest, viii
started with Jury Instruction Selector, 13
web updates, ix
Given As Modified command, 78
Given As Modified flag, 77-78
Given As Requested command, 78
Given as Requested flag, 77-78
Global Brackets and Blanks Reviewbut ton, 68
Global Brackets and Blanks Reviewwindow, 69
Global SpellCheckbutton, 69-70
Globd SpellCheckcommand, 69-70
Gotodrop-down list, 56-57

H

headers in Personallnstructions, 108
help
unlocking modules, 6
Help command, 17
Help system, viii, 17
Highlight case information fields that appearin the selectedinstruc-
tions, 23
Highlight changes ininstruction text, 23
highlighting
case informationfields, 23, 46-50
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ininstructiontext, 23 Jury Instruction Selector
History Index, 92 closing, 33
History page (Jury Instructions tab), 56 downloading updates, ix, 11
History Table gettingstarted, 13
defined, 76 installing, 3
in Los Angeles County Forms 176/177 format, 86 localinstallation, 3
inSinglePageformat, 85 networkinstallation, 7
Status flags, 77 newfeatures, 17
working with, 76 overview, 1
hours for customer support, ii starting, 13

system requirements, 2
| uninstalling files, 11
workst ation installation, 9

IgnoreAll button, 69-70 Jury Instruction Selector window, 14
Ignorebutton, 69-70 Jury Instructions tab, 16, 54
Import Instructions window, 63 Chapters/Sort page, 55-56
importing instructions, 62-63 History page, 56
installation Master Instructions page, 54
alternative operating environments, viii, 2 Personallnstructions page, 55
canceling, 3 Selected Instructions page, 55
important notices, 2 jury instructions, printing, 79, 96
local, 3
network installation, 7 K
stand-alone PCs, 3
system requirements, 2 key codes, ii, 6
types of, 3
web updates, ix, 11 L
workst ations, 9
InstallShield Wizard, 3 L.A. County Forms format
instruction # field, 57 History tablein, 86
Instruction Information window, 102, 109 illustrated, 86
instruction lists print options, 82
closing, 39 L.A. County Forms page (Print tab), 81
defined, 35 laser printers, 2
deleting, 39 Last Pagebutton, 96-97
opening, 38 License Agreement window, 4
saving, 36 license key codes, 6
saving as instruction sets, 37 Life Expectancy Tablecommand, 32-33
instruction numbers, conflicting, 110 links to case laws and statutes, 60
instruction sets Linux, viii, 2
addinginstructions to, 61 list of instructions, printing, 98
chapters, 24 localinstallation, 3
choosingwhich to display first, 23 locations, 49
closing, 39 looking up where caseinformation is used, 51
defined, 35 Los Angeles County Forms 176/177 format, 81, 96-97
deleting, 39 illustrated, 86
deleting instructions from, 73
History Table and, 76 M
importing instructions, 62-63
opening, 38 » Mac OS, viii, 2
opening instructions for editing, 64-65

"ng maintoolbar, 14, 16
previewing onscreen, 96-97 Make Verdict button, 72

renaming, 37 managing Jury Instruction Selector files, 35
reorderingchapters, 73-74 Master Inst ructions

saving,36 auto-populate fields in, 59, 66
saving instruction lists as, 37 conflicts with PersonalInstruction numbers, 110

setting display size, 23 defined, 54

Internet definition of, 54
accessto, 2 jumpingtofirst of onetype, 56-57
updates on, ix, 11 printing text of, 60, 98

Internet browsers, 2

searching forand within, 56
Internet Explorer, 2

searching for text, 57

Items & Locations page(Case Information tab), 49 Status flags, 77

viewing text of, 59
J working with, 53

Master Instructions page (Jury Instructions tab), 54

JavaScript, 2 memory requirements, 2
jil files, 35 menu bars, 14
jis files, 35 Microsoft Word, 94, 97
Judge name, 42 Miscellaneous page (Case Information tab), 50
Judicial Council ofCaliforniaCivil Jury Instructions, 1 missing page numbers, 83, 97

jumping tofirst Master Instruction ofonetype, 56-57
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monitors, 2
Move Chapter Down button, 73-74
Move Chapter Up button, 73-74
Move Down command, 73-74
Move Up command, 73-74
moving, 73-74

chaptersinlist, 73-74

through previewed pages, 96-97
MSI workstation installation, 2

N

navigating through previewed pages, 96-97
network distribution, 3
network installation, 3
setting up toinstall from network, 7
workst ation installation, 9
Newbutton, 36
Newcommand, 35
newfeatures, 17
New InstructionSet window, 14, 36
Newlnstruction window, 105
Next Pagebutton, 96-97
None command, 78
notification of web updates, ix, 11
Novell, viii, 2

0]

Openbutton, 38-39
Open command, 38-39
Open Instructions window, 38
opening
chapter defaults for modifying, 27
instruction files, 38
Jury Instruction Selector, 13
Master Instructions, 59
Personallnstruction for editing, 103-104
Selected Instructions, 64-65
operating systems
compatibility with, viii, 2
Options command, 18, 20-22, 27
Options window
Alerts tab, 20
Book Chapters tab, 27
Courts & Attorney tab, 19
Display tab, 23
Other tab, 21-22, 95
order of chapters, 73-76
organization of user guide, vii
orientation of paper, 93
Other (Party) flag, 76-77
Other command, 77
Other Party Name window, 77
Other tab (Options window), 21-22, 95

P

pageorientation, 93
pagetoolbars, 16
paper, 93

options for printing, 93

pleading, 84
Parties page (Case Information tab), 43-44
Party Details window, 44
party information, exluding fromA uto-Populate, 44
Party Types page (Case Information tab), 46
PCLemulation, 2
PDF documents

What's New, viii

Personallnstructions, 101
adding auto-populate fields to, 106-107
adding gender phrases to, 107-108
conflicts with Master Instruction numbers, 110
defined, 54, 101
defining text of, 104-105
definition of, 54
deleting, 109-110
editing, 108
headers, 108
master versions of, 108
opening for editing, 103-104
renumbering, 110
startinganew, 101-103
titles, 108
Personallnstructions page (Jury Instructions tab), 55
phone numbers, 6
phonetraining, vii
Plaintiff/People command, 77
Plaintiff/People flag, 76-77
Pleading format, 84, 91
illustrated, 91
print options, 84
Pleading page (Print tab), 84
pleading paper, 84
Present Value Tablecommand, 32
previewb alloons for auto-populate fields, 59, 66
previewwindow, print, 97
previewing documents before printing, 96-97
Previous Page button, 96-97
print-to-filefiletype, default, 94-95
print fonts, 93
print formats, 85, 96
Print Instruction List window, 99
print options
Booklet format, 83
L.A. County Forms format, 82
Pleading format, 84
Single Page format, 81
print preview window, 97
Print Setup command, 93
Print Setup window, 93
Print tab, 16, 80
Booklet page, 82
Chocse Instructions page, 80, 95
L.A. County Forms, 81
Pleading page, 84
Single Pagepage, 80-81
printers
requirements, 2
selecting, 93
printing, 79
Booklet format, 24
choosinginstructions for, 95
Commentaries, 98
default print-to-file filetype, 94-95
default printer selection, 93
individualinstru ction, 98
jury instructions, 96
list ofinstructions, 98-99
Master Instruction text, 60
overviewof, 79
previewing before, 96-97
toword processing or PDF files, 97-98
verdict forms, 84
processer requirements, 2
product CDs, 3
Proposed command, 78
Proposed flag, 77-78
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Quick Start Guide, viii, vii, 13
R

RAM requirements, 2
ranges of instructions, 27-29
recovery file, 21
reference materials

civil, 31

criminal, 32

viewing, 31
References menu, 31-32
Refused command, 78
Refused flag, 77-78
reinstalling Jury Instruction Selector, 11
Related Instructions window, 62
related jury instructions, 61

selecting, 61
removing

instructions from yourinstruction set, 73

Requested-By flags, 77

Status flags, 78
renaming instruction sets, 37
renumbering a Personal Instruction, 110
reordering chapters, 73-74
Replace command, 70-71
Replace window, 71
replacing

existing instructions, 63

text automatically, 65

text ininstructions, 70-71
request for jury instructions pleading, illustrated, 91
Requested-By flags, 76, 91
Requested By >Court command, 77
Requested By > Defendant command, 77
Requested By > Other command, 77
Requested By > Plaintiff/ People command, 77
Requested by Plaintiff/People flag, 77
Requested column, 76-77
requirements, system, 2
Reset Order button, 76
Reset Order command, 76
resetting the titles and order of chapters, 76
resources, companion, viii
RestoreDefaults button, 30
restoring

chapter defaults, 30

chapter titles and order, 76
revertingverdicts toinstructions, 72
reviewing brackets and blanks, 67-68
Rights Management window, 6

S

Safari, 2
samples
Booklet format, 88-89
Disposition Table, 92
Form176/177,87
Index in Booklet format, 90
Pleading format, 91
Single Page format, 85-86
Table of Contents in Booklet farmat, 88
SaveAs command, 37-38
Savebutton, 36
Savecommand, 36
Savelnstruction Set window, 37
Save Instruction window, 36-37
save location, default, 21
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saving, 37
edited Selected Instructions, 65
instruction lists as instruction sets, 37
instruction set under adifferent name, 37
instruction sets or lists, 36
screen resolution, 2
Search button, 57
Search command, 57
Search window, 58
searching
by instruction number, 56-57
fortext ininstru ctions, 70-71
for text in Master Instructions and Commentaries, 56-57
Select Chapter Title window, 74
Select/Deselect button, 73
Selected Instructions
auto-populating, 65
brackets and blanks in, 67-68
checking spelling, 69-70
converting toverdicts, 72
defined, 54
definition of, 54
deleting instructions, 73
editing associated chapter title, 74-75
imparting fromanctherinstruction file, 62-63
opening for editing, 64-65
printing, 96
printing text of, 98
related jury instructions, selecting, 61
Requested-By flags, 76
reviewing brackets and blanks, 67-68
saving after editing, 65
searching for and within, 56
selecting for inclusion ininstruction file, 61
Status flags, 77
working with, 53
Selected Instructions page(Jury I nstructions tab), 55
selecting
instructions for inclusionininstruction file, 61
related instructions, 61
send feedback, ix, 18
Server, Windows, 2
setting
default fonts for printing, 93
default print-to-file file type, 94-95
default printer, 93
default save location, 21
display options, 22
format options for printing, 96
setup options for printing, 93
Setup Type window, 5, 8-9
setup.exe, 2
Show allcaseinformation inbold, 23
Single Pageformat, 80-81
illustrated, 85
print options, 81
Single Pagepage (Print tab), 80-81
SpellCheckbutton, 69-70
Spell Checker window, 69
spelling, checking, 69-70, 105
stand-alone PCinstallation, 3
startinstruction inachapter, 27-29
Start tab, 15
starting
Jury Instruction Selector, 13
newPersonal Instruction, 101-103
Startup Options window, 14, 20
turning off, 20
Status > Given As Modified command, 78
Status >Given As Requested command, 78
Status > Nonecommand, 78
Status > Proposed command, 78
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Status > Refused command, 78
Status > Withdrawn command, 78
status bar, 14, 36

Status column, 78

Status flags, 76-77, 91
storagerequirements, 2

Suggest button, 69-70

suggested spellings for words, 69-70
system requirements, 2

T

tabtoolbars, 16
Table of Contents in Booklet format
illustrated, 88
missing page numbers in, 83, 97
tabs, 14-15
telephone numbers, ij, vii
customeservice, viii
customer technical support, viii
key codeassistance, 6
telephone training, viii
templates
saving instruction lists as, 37
Terminal Services, viii, 2
text, highlightedininstructions, 65
title bar, 14, 36
titles
Personal Instructions, 108
restoringc hapter titles, 76
toolbars, 14
main, 16
overview of, 16
page, generally, 16
tab, generally, 16
windows, generally, 16
tour ofmain window, 14
tracking history of instructions, 76
training, viii
Trialdate, 42
troubleshooting
key codes, 6
turning features on or off
File Recovery feature, 21
Startup Options window, 20

u

uninstalling Jury Instruction Selector, 11
updates, web, ix

URLs for Jury Instruction Selector, ix, 11
Use Division Title, 42

\'

verdict forms, 84
verdicts
convertinginstructions to, 72
revertingtoinstruction format, 72
ViewCommentary button, 98
ViewCommentary command, 60
View Commentary window, 61
Viewlnstruction command, 59
View Instruction window, 59
viewing
Commentaries, 60
Master Instructions, 59
reference materials, 31
Vista, Windows, 2

W

web browsers, 2
webupdates, ix
Welcomewindow, 3
West
account, ii
customer support, ii
unlocking modules, 6
West account, viii
Westlaw, 2, 30
Westlaw Access information window, 30
Westlaw Online Research command, 30
Westlaw Online Research window, 31
What's Newcommand, 17
What's NewPDF, viii
what's new?, 17
windowtoolbars, 16
Windows 10, 2
Windows 7, 2
Windows 8, 2
Windows Server, 2
Windows Vista, 2

windows, accessing Help information for, 17

Withdrawn command, 78
Withdrawn flag, 77-78
Word, 94
WordPerfect, 94, 97
words, 69-70
adding to dictionaries, 69-70
suggested spellings, 69-70
workingwith juryinstructions, 53

Workstation Default Save Folder window, 9

workst ation installation, 2-3
copying files to network, 7
steps, 9
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